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Forew Word 
 

Thank you for purchasing the programmable video signal generator. 
This manual provides details on how to use the SP-8848 software program to edit, create, send and receive data 
used for the programmable video signal generator (hereafter abbreviated to "VG"). (The figures and diagrams 
referred to in this manual show what applies when the VG-848 has been connected, and there may be 
differences when connections are made with another VG. Refer to the help provided for each editing program. 
The basic operating methods are the same no matter which model VG has been connected.) 
This manual describes how to use the SP-8848. For details on specific setting items, settings or other such 
aspects, refer to the SP-8848 help or the instruction manual of the VG concerned. 
After reading through this manual, keep it in a safe place for future reference. 

 

 

SAFETY PRECAUTIONS 
WARNING  

 

� Concerning foreign matter 
● Do not spill liquids onto the product or drop inflammable objects or metal parts onto it. Use under these 

conditions may cause a fire, electrical shock or malfunctioning. 
 

 

CAUTION  
 

� Concerning the installation and operating locations 
● Install this product in a stable place.  
● Before installing the product, be absolutely sure to turn off the power of the computer and unplug its power 

cable. 
 
� Concerning impact 
● This is a precision piece of equipment and, as such, subjecting it to impact may cause malfunctioning. Take 

special care when moving the product. 
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11  About the SP-8848 
 

1.1. General 
The SP-8848 is an application software program for operating the VG-848, and it is designed to run in a Windows 
environment. It enables the statuses of the VG-848 to be captured and its settings to be changed. It can also create 
data and execute the data which has been created. 
All operations are conducted at the personal computer, and the data created can be stored in the computer as files. 

1.2. Features 

1.2.1. Software program compatible with Windows 
This program enables data to be edited and executed in a Windows environment. 

1.2.2. Simple data management functions with a high degree of freedom 
Timing data and pattern data can be organized separately in their own files. Data management can easily be exercised 
by such features as the list display, sort function and naming function. 

1.3. Software installation 
This section describes how to install the files which are used for operating the SP-8848 in a Windows environment.  
These instructions apply to the installation which involves the use of the following disk. 
SP-8488 installation CD, Windows edition  

1.3.1. Installing the SP-8848 
(1) Place the SP-8848 installation CD in the CD drive, and in Windows select [Start] → [Settings] → [Control Panel] → 

[Add/Remove Programs] → [Install]. The installer now starts up, and the setup begins. 
 
(2) The "Welcome" dialog screen is the first to appear. When the 
[Next] button is clicked, the setup advances to the next step; 
conversely, when the [Back] button is clicked, it returns to the 
previous step. The setup is aborted by pressing the [Cancel] 
button. 

 

Click the [Next] button. 
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(3) On the "Select installation destination" dialog screen, select the 
directory into which the SP-8848 is to be copied. As the default, the 
"ASTRO¥SP-8848" directory is created in the C: drive root 
directory, and the files are copied into it. The copy  destination 
directory can be changed to any directory specified by the user. 
Click the [Browse] button and set the directory. 

 

 
 
 
 
 
(4) Select the [Install] button. The file installation dialog screen now 
appears, and installation begins. 

 

 
 
 
 
 
 
 
 
 
(5) The setup is now completed. Press the [Finish] button. 

 

 
 
 
 
 
 
 
 
 
 
(6) The user is now prompted to restart the PC. Be absolutely sure 
to select [Yes]. 

 

 
 
 
 
 
 
(7) The installation is now completed. In Windows, select [Start] → [Programs] → [SP-8848] → [Guide Help] and read 
through the guide help. Then select [Start] → [Programs] → [SP-8848] → [VGBase] to start up [VGBase]. 
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1.3.2. Installing the USB driver 
(1) When the system is connected with the VG for the first time, it recognizes the VG, and the [Add New Hardware 

Wizard] dialog box appears. Select the [Next] button. 
(2) Select [Search for optimal driver for device in use (recommended)] as the search method, and select the 

[Next] button. 
(3) Place the SP-8848 installation CD in the CD drive, check [Specify search location], specify CD drive 

and select the [Next] button. 
(4) Check that "VgUsb.sys" has been found, and then select the [Next] button. Installation now begins. 
(5) For the remaining steps, follow the on-screen directions. 
*When installing the driver in Windows XP, the following dialog box appears referring to the fact that Microsoft 
has not officially certified its use. Press the [Continue] button. 

 

 

 

 

 

 

 

 

 

 

 

1.3.3. Uninstallation method 
In Windows, select [Start] → [Settings] → [Control Panel] → [Add/Remove Programs], and delete the software by 
following the on-screen directions. 
During this process, the user will be asked whether to delete "VGPIO.vxd" which has been installed in the Windows 
system directory. Leave it if it is required. However, if the software is to be re-installed, the files and registry settings 
must be deleted by uninstalling them before proceeding. The data files in the VGInt directory and UserChar directory 
are read-only files and, as such, they are not deleted by uninstallation. Delete them separately. Similarly, if the USB 
driver has been installed, it will not be deleted by uninstallation either, so delete it separately. 



 
 

1.3.4. Directories and files 
The directory and files listed below are created by the installation of the software. 

Specified directory (default: C:¥ASTRO¥SP-8848) 

 
 

Data (data files used by the data editing programs) 
(*.lot) 
Sample.lot 

 
AutoDispt 
(*.adp) 
Sample.adp 

 
Group 
(*.grp) 
Sample1.grp，Sample2.grp 

 
Image 
(*.vbm) 
usagi.vbm 
XGA.vbm 
SXGA.vbm 
UXGA.vbm 
1080_10bit.vbm 
(*.bmp) 
usagi.bmp 
XGA.bmp 
SXGA.bmp 
UXGA.bmp 

 
OptPtn 
(*.mc) 
g1_test.mc/g8_test.mc/window.mc/ptn_test.mc/256_col.mc/CbarGray.mc/IMG1.m
c/Crosst90.mc/CheckWin.mc/10_step.mc/cs_cr_ch.mc/cs_cr_gr.mc/DispAdj.mc/G
rayCirc.mc/RGBW_bar.mc/smpte271.mc/ 
(*.mo) 
g1_test.mo/g8_test.mo/window.mo/ptn_test.mo/256_col.mo/CbarGray.mo/IMG1.
mo/Crosst90.mo/CheckWin.mo/10_step.mo/cs_cr_ch.mo/cs_cr_gr.mo/DispAdj.mo
/GrayCirc.mo/RGBW_bar.mo/smpte271.mo 

 
Program 
(*.prg) 
SVGA.prg/CGA.prg/EGA.prg/PGA.prg/XGA.prg/UXGA.prg/VGA1.prg/VGA2.pr
g/VGA3.prg/XGA.prg 

 
Temp 

 
UserChar 
(*.uch) 
VGIntF0.uch - VGIntF7.uch 

 
VGInt 
(*.prg) 
VGInt850.prg - VGInt999.prg 
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Exe (executable files of SP-8848) 
(*.exe) 
ADEdit.exe/CharEdit.exe/CnfgEdit.exe/GrpEdit.exe/LpEdit.exe/OptEdit.exe/PrgEdit.
exe/ 
 

VbmCvt.exe/VGBase.exe/VGManage.exe/CDCEdit.exe/CurTool.exe/Monitor.exe/VersionUp.e
xe/ 

(*.dll) 
CmdDll.dll/GuiCmd.dll/ADDll.dll/CharFile.dll/CVSBMP.dll/GrpSetDll.dll/Layout.dl
l/LimitDll.dll/OptPtnFile.dll/PrgFiles.dll/RegDll.dll/TransDll.dll/TransUsb.dll/DDCE
dit.dll/DDCFile.dll/CDCFile.dll/ImgCom3.dll/imged32.dll/ImgEtc3.dll/ImgFile3.dll/I
mgTiff3.dll/ImgDsp3.dll/IpDlg.dll/ 
(*.msg) 
SP_VG.msg/SPErr.msg/VGErr.msg/ 

 
OptDoc (text describing how to create the optional patterns) 

make_OPT.txt 
 

Help (help files) 
(*.hlp) 
ADEdit.hlp/GrpEdit.hlp/PrgEdit.hlp/CnfgEdit.hlp/CharEdit.hlp/VbmCvt.hlp/VGBase
.hlp/LpEdit.hlp/OptEdit.hlp/make_opt.hlp/VgManage.hlp/Vgerrmsg.hlp/Guide.hlp/D
DCEdit.hlp/CDCEdit.hlp/CurTool.hlp/VerUP.hlp/ 
(*.CNT) 
ADEdit.CNT/GrpEdit.CNT/PrgEdit.CNT/CnfgEdit.CNT/CharEdit.CNT/VbmCvt.CN
T/VGBase.CNT/OptEdit.CNT/make_opt.CNT/VgManage.CNT/Guide.CNT/DDCEdi
t.CNT/CDCEdit.CNT/CurTool.CNT/VerUP.CNT/ 

 

1.3.5. Other files 
File copied into the [¥Windows¥System] directory by the software installation 
VGPIO.VXD 
 

File copied into the [¥Windows¥System32¥Driver] directory by the USB driver installation 
VGUSB.SYS 
 

File copied into the [¥Windows¥Inf] directory by the USB driver installation 
VGUGB.INF 
 



 
 

1.3.6. Registration of Registry 
 
The data is registered in the registry as below. 
 HKEY_LOCAL_MACHINE 
 ¥Software¥Astrodesign¥SP8848¥ 
 
By starting up SP-8848, the data is copied from the above registry to the below registry. 
 HKEY_CURRENT_USER 
 ¥Software¥Astrodesign¥SP8848¥ 
 

When uninstalling it, the data after ¥SP8848 in “HKEY_LOCAL_MACHINE” is deleted, however, the data after 
¥SP8848 in “HKEY_CURRENT_USER” is not deleted.  If the data after ¥SP8848 in “HKEY_CURRENT_USER”needs 
to be deleted, it should be done manually. 

 
* Please be careful when you delete registry data manually.  If the data in the wrong place is deleted, the 
Window OS may not start up. 
* ASTRODESIGN does not take any responsibility to any result (including direct result and indirect result) after 
user deletes the registry data manually.   

 

1.3.7. Usage as Multiple Users 
When using SP-8848 by “Multiple Users”, please install it as below. 
(1) Install SP-8848 as “Administrator”.  Some files and registries can not be installed if “Administrator” is not selected. 
(2) Re-log-in with the other user name. 
(3) Start up SP-8848.  Then, it can be used as it is. 
 
* If SP-8848 version is before 4.01, please follow the below instruction. 
(1) Install SP-8848 as “Administrator”.  Some files and registries can not be installed if “Administrator” is not selected. 
(2) Re-log-in with the other user name. 
If it is installed as Administrator, Exe file and short cut can be seen with Power Users, however, registry has to be 
re-installed because it is set by user. 
(3) Select SP-8848 in the [START] – [SET] – [Control Panel] – [Add and delete Application] . 
Then, click the below figure. 

 
 
 
 
 
 
 
 

 
 

6



Chapter 1 About the SP-8848
 

 
 

7

The below screen is shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(4) By pressing “Repair” button, SP-8848 is re-installed. 
 
(5) When repair work is done, SP-8848 can be used. 
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22  Operation 
 

2.1. General 
The basic operations consist of starting up "VGBase," creating and editing data, sending the data to and receiving it 
from the VG, and storing the created data in the memory. The layout data used by "VGBase" is grouped together in sets, 
and the data, data numbers, codes, etc. sent to the VG are retained in the memory. (For details on how to create and 
edit the sets of data, refer to the help sections in the editing programs concerned.) 

 

*Each setting screen is a thing at the time of VG-848 connection. Setting 
screens may differ at the time of connection with other VG(s). 

2.2. Starting up VGBase 
 

P 

(1) Sele
 

*Whe
VG w
When

 

(2) The
the [T
and t
Type
comm
(See 

 

 

 

 

 

 

 

rocedure for starting up "VGBase" 

ct [Start] → [Programs] → [SP-8848] → [VGBase]. 

n connecting with VG-848, 849, 835, 859 and 830, SP reads the version number of  
hen SP starts.  If the version is before 2.00, the message appears. 
 message appears, upgrade the firmware of VG first. 

 "Select VG Type" dialog box for setting the VG type now appears. Select the VG Type from the options given in 
ype] combo box, and click the [OK] button. (Once the VG Type is selected, the selection is stored in the memory, 

he dialog box will no longer be displayed when the software program is next started up.)  Before the "Select VG 
" dialog box appears, a "Warning" message (Com Port Open Error) may be displayed. This means that 
unication with the VG has not been established: after starting up "VGBase," perform the configuration settings. 

"Configuration settings" in Section 3-3.) 
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(3) The "Layout Info Setting" (layout data setting) dialog box for setting the data at startup appears. If layout data is to be 

used, select [Use Layout File], and click the [OK] button. Otherwise, select [No Info], and click the [OK] button. If the 
no data layout will be used, "VGBase" is started up here. 

 
 
 
 
 
 
 
 
(4) When the layout data is going to be used, the "Load File" file selection dialog box appears. (It does not appear when 

the layout data is not going to be used.)  Select the "Sample.lot" file in the Data directory (default: 
"C:¥Astro¥SP-8848¥Data"), and click the [OK] button. (When a new file is to be created, enter its filename in the [File 
Name] box.) 

 
 
 
 
 
 
 
 
 
 
 
 
(5) The sample layout data is now loaded into "VGBase" and "VGBase" is started up. 
 
 
 
 
 
 
 
 

In order to perform the interface and other settings, the configuration settings must be 
performed once when the VG is started up. (See "Configuration settings" in Section 3-3.)
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2.3. Closing VGBase 
 

P 

Click th

2.4. 
 

 Pr

2.4.1. 
Click th
configur

2.4.2. 

■ Env

 
 
 
 

rocedure for closing "VGBase" 

e [Close] button. 

Configuration settings 
ocedure for changing the VG execution mode and other configuration settings 

Startup method 
e [Config] button of "VGBase."  This starts up the "Configuration Editor" program which performs the 
ation settings. 

Window screen and description 

ironment page 
The directory containing the data files can be set on this page. 

 
 
Model Name The VG model name is indicated here. 
Data Dir The directory in which the data is stored is set here. Under normal 

circumstances, no changes should be made to the directory since it 
requires a specific structure. 
All the settings must match the communication parameters which are set for the
VG unit. As such, special care is required when setting or changing the items on
 11



 
 
 

Click [Apply] so that the configuration settings will take effect and the actual changes will be made. When this button is 
clicked on the [Interface] page, the commands are sent to the VG unit and the settings are changed only if 
communication is enabled. If communication is disabled, only the configuration data managed by the PC will be 
updated. 

 

Click [Clos

■ Interfa
The param
 

S
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Bear in mind that even when the settings have been changed, these changes will
be lost if the software is closed without clicking the [Apply] button first. 
e] to close the configuration setting program. 

ce page 
eters for communication with the VG unit can be set on this page. 

 

Select the communication
method here. 

electing the communication method 
Enable This setting enables communication and allows "VG (Serial)," "VG (LAN)" or 

"PC" to be set. The setting items differ depending on the VG model. 

VG (Serial) This setting selects the RS-232C port to be used as the communication method. 
VG (LAN) This setting selects the LAN to be used as the communication method. 
PC This setting selects access to the memory card, which is connected directly to the 

PC and on which is written the data, as the communication method. 
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When VG (Serial) has been selected as the communication method: 

 

 

Port The port number is selected here. 
[Sense] button This is used to detect the setting speed of the VG automatically. 
Speed 9600, 19200, 38400, 57600 or 115200 is selected as the transfer rate 

setting here. 
Data Size This setting selects the communication data size (fixed at 8 bits). 
Parity Even, Odd or None is selected as the parity setting here. 
Stop Bits 1, 1.5 or 2 bits are selected as the Stop Bits setting here. 

 

When VG (LAN) has been selected as the communication method: 

 

 

Port No. VG The VG port number is selected here. The default setting is 8000. 
(*1) 

Port No. SP The SP port number is selected here. The default setting is 4000. 
(*1) 

[Edit] button This is used to display the IP address setting dialog box. 
[Delete] button This is used to delete the VG selected on the list. 



 
 

*1: As a general rule, use the default value for the port number. If it cannot be used due to the network 
connected, change to a different port number for use. 

 

When the [Edit] button is pressed, a setting dialog box such as the one shown below appears. 
 

 

 

 

 

 

 

 

Name The VG name is displayed here. 
IP Address The IP address is displayed here. 

 
When PC has been selected as the communication method: 

 

Memory Card Drive The drive to which the memory card (*) is connected is selected 
here when PC has been selected as the communication method. 

*Use the Compact Flash (CF) card provided with the VG-848 as a standard accessory for the memory card. 
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■ Control page 
The display mode settings of the VG can be changed on this page. 

 

Display "Direct Display" or "Group Display" can be selected here as the 
display mode. When the "Group Display" mode has been selected, 
the "Group" number must be specified. 

 

 

 



 
 

2.5. Creating and editing the program data 
 

 

 

This section describes how the VG program data is set. Program data can be created, edited, 
sent to the VG, registered on the panel ROM or memory card, executed and received from the 
VG. 

2.5.1. Startup method 
Click the [Program] button of "VGBase" to start up the "Program Editor."  When the editor starts up, the timing data 
setting screen appears as the default display. 

2.5.2. Window screens and description 

■ Common setting screen 

Tool buttons 

Help display Filename 
Program data 

number 

 
Program number 
The number of the program data registered in the VG is displayed here. 
 
Enable 
Whether the program is to be sent to the VG and executed is set here. 
 
Filename 
The name of the file currently opened is displayed here. 
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Help 

Help details are displayed by pressing the  button. 
 

Tool buttons 

Show Err: When the  button is clicked, the error window is displayed. Check the values of the 
data which has been set. If a value outside the setting range has been input, which data contains 
the error is indicated on the error description display screen. 

 

Execute:  When the  button is clicked, the program data now being edited is executed 
without its being registered in the VG. 

 

Load:  When the  button is clicked, the program data is loaded. 
 

Save:  When the  [Save] button is clicked, the program data is saved in the file and any 
existing data in that file is overwritten. 

 

Save As: When the  button is clicked, the program data is saved in the file. 
 

Send:  When the  button is clicked, the program data now being edited is sent to the VG. 
 

Receive:  When the  button is clicked, the program data is received from the VG. 
 

Print:  When the  button is clicked, the program data is printed. 
 

Close:  When the  button is clicked, the program whose data has been edited is closed. 
 



 
 
Basic operations 
①Loading a file 

Before creating new data, proceed with "Creating and editing the program data" in (2) on the next page. 
1) Press the [Load] button to open the "Load File" file selection dialog box. 
2) Select the filename. 
3) Select the type of the program data ([Timing], [Output], [Pattern] or [Action]) to be loaded, and press the [OK]  

button. Only the selected data is now loaded. The data which has not been selected is not updated. 
4) The data of the selected file is displayed in the program data editing program. 
¾ If the layout has been set 

The number of the program data registered in the layout is displayed at [No.]. 
¾ If the layout has not been set 

[No.] is cleared. 
(*)When [Internal Program] has been checked 

Load the file containing the program data registered in the ROM inside the VG. However, NTSC, PAL, SECAM, 
1080i, 1080p, 1035i and 720p signals are standard signals and, as such, they cannot be edited using this software. 

Filename Program data No. 
VGInt850.prg 850 

: : 
VGInt999.prg 999 

 

 When, while loading the data of an old model, the data of setting items featured with the VG-848 
but not with the old model has been loaded into the SP-8848, default values (0 or the minimum 
value) will be entered into those items. For details, refer to the SP-8848 help or the instruction 
manual of the VG concerned. 

 

 

 

②Creating and editing the program data 
To set the timing data (horizontal timing, vertical timing): 
→ Click the [TIMING] button. 

To set the output conditions (analog output, digital output): 
→ Click τηε [OUTPUT] or [ANALOG OUTPUT] or [DIGITAL OUTPUT] button. 

To set the pattern data (selecting the display pattern, setting the pattern data): 
→ Click τηε [PATTERN] button. 

To set the action data: 
→ Click the [ACTION] button. 

To set the audio data: 
→ Click the [AUDIO] button. 

(*) A setting with an error is displayed in red. A list of setting errors can be viewed by pressing [Show ERR]. 
 

 With some VG models, changes have been made to the screens, setting items, setting value ranges, etc. 
For details, refer to the SP-8848 help or the instruction manual of the VG concerned. 
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③Saving the file 
After changing the program data, click the [Save] button or [Save As] button to save the data in the file. 
¾ When the [Save] button is clicked: 

The data is saved in the file and any existing data in that file is overwritten. 
¾ When the [Save As] button is clicked: 

1) The "Save File" file selection dialog box appears. 
2) Input the filename, and select the [OK] button. The displayed data is now saved in the new file. 
 
④Sending the program data 

1) Select the [Send] button. The "Send to VG" number selection dialog box appears. 
2) Set the number (0 to 849) of the program data. 

Data number  
0 After the data is sent, it is executed immediately 

without being registered. 
[with Execute] checked After the data is sent, it is registered and executed 

immediately. 
1 - 
849 

[with Execute] unchecked After the data is sent, it is not executed but only 
registered. 

 
3) Click the [OK] button. The data is now sent to the VG. (The number of the data sent now replaces the previous 

number appearing in [No.].) 
(*) The name of the program data can be set by inputting it into [Program Name] of the [NAME] program data name 

setting tab on the pattern data setting screen. 
 

⑤Receiving the program data 
1) Select the [Receive] button. The "Receive from VG" number selection dialog box appears. 
2) Set the number (1 to 999) of the program data. 
3) Select the data (Timing, Output, Pattern or Action) to be received, and click the [OK] button. Only the data selected 

is loaded. Unselected data is not updated. 
4) The data is received from the VG. (The number of the data received now replaces the previous number appearing 

in [No.].) 
 
⑥Printing the program data 

1) Click the [Print] button to print the data prepared. 
2) The "Print" dialog box appears. Set the margins here. 
3) Click the [OK] button. The displayed data is now printed. 
4) To change the printer which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. Perform the printer settings. For details on how the items on this dialog box 

are set, refer to the instruction manual for Windows or for the printer which will be used. 
 
 
 

Program data can be received using an old VG model but except VG-828 it cannot be sent to one. 



 
 

■ Timing data setting screen 
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Timing data settings 
[Frequencies] 

Dot clock frequency 5.000 to 300.000 MHz 
Horizontal sync frequency 10.000 to 300.000 kHz 
Vertical sync frequency 15.600 to 200.000 Hz 

 
[Horizontal timing data] 

H Period 0.000 to 99.999µsec 128 to 8192 dot 1-dot increments 
H Disp  0.000 to 99.999µsec 48 to 4096 dot 1-dot increments 
H Sync 0.000 to 99.999µsec 0 to 4096 dot 1-dot increments 
H Backp 
H Frontp 

0.000 to 99.999µsec 0 to 4096 dot 1-dot increments 

HD start 
HD width 

0.000 to 99.999µsec 0 to 4096 dot  1-dot increments 

H Blanking Calculated automatically  1-dot increments 
 
[Vertical timing data] 

V Total 0.000 to 99.999msec 4.0 to 8192 H  1H increments 
V Disp 0.000 to 99.999msec 1.0 to 4093 H 1H increments 
V Backp 0.000 to 99.999msec 0.0 to 4000 H 1H increments 
V Sync 0.000 to 99.999msec 1.0 to 99 H 1H increments 
EQP fp 0.000 to 99.999msec 0.0 to 99 H 1H increments 
EQP bp 0.000 to 99.999msec 0.0 to 99 H 1H increments 
Start 0.000 to 99.999msec 0.0 to 4095 H 1H increments 
Line 0.000 to 99.999msec 0.0 to 4095 H 1H increments 

 
 



 
 

■ Output condition data setting screen 

 
 Output condition data setting screen 

 

[Setting the data] 
● Select the applicable radio buttons. 
● Where an edit box is provided, align the mouse cursor with the data to be changed, and click the mouse. The data 

can now be keyed in. 
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Output condition data settings 
Mode ANALOG, Tri-Sync (1080) ,Tri-Sync (720) ,NTSC ,PAL ,SECAM is selected here. 
HS "NEGA," "POSI" or "OFF" is selected here as the HS polarity setting. 
VS "NEGA," "POSI" or "OFF" is selected here as the VS polarity setting. 
CV "OFF," "R," "G," "RG," "B," "RB," "GB" or "RGB" is selected here as the CV setting. 
CS "NEGA," "POSI" or "OFF" is selected here as the CS polarity setting. 
VIDEO LEVEL A voltage level from 0.3 to 1.0V is set here as the video level. 
SET UP A voltage level from 0 to 0.25V is set here as the setup level. 
SYNC LEVEL A voltage level from 0 to 0.06V is set here as the sync level. 
PbPr No. A number from 0 to 9 is set here as the color difference table number. 
RGB/Y,B-Y,R-Y Either "RGB" or "Y,B-Y,R-Y" is set here as the color difference setting. 
DVI Mode Either "Single" or "Dual" is selected here as the DVI output setting. 
D Conector(Line1) "480," "720" or "1080" is selected here as the Line1 setting. 
D Conector(Line2) "Interlace" or "Progress(ive)" is selected here as the Line2 setting. 
D Conector(Line3) "4:3," "4:3LB" or "16:9" is selected here as the Line3 setting. 
S Conector "Normal," "Letter Box" or "Squeeze" is selected here as the S Connector output. 
Analog(BNC) "ON" or "OFF" is selected here as the Analog (BNC) setting. 
Analog(D-SUB) "ON" or "OFF" is selected here as the Analog (D-SUB) setting. 
DVI(Digital) "ON" or "OFF" is selected here as the DVI (Digital) setting. 
DVI(Analog) "ON" or "OFF" is selected here as the DVI (Analog) setting. 
D Conect "ON" or "OFF" is selected here as the D Connect setting. 

 



 
 

■ Pattern data setting screen 

Buttons for setting the
respective patterns Buttons for selecting

the patterns 
Character pattern
settings 

 

 

 

 

Selecting the patterns 
Select the pattern to be displayed while the VG is running. 
Select "Multi Pattern" or "Single Pattern" as the Mode setting. ("Multi Pattern" is the default.)  NAME, R, G, B and INV 
can be set at the same time for any of the patterns. 
 
● When "Multi Pattern" is selected : The OPT1 and OPT2 patterns cannot be set at the same time. A multiple number 

of the other patterns can be set at the same time. 
● When "Single Pattern" is selected : A multiple number of patterns cannot be set at the same time. 
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Pattern selection 
CHARA Character 
CROSS Crosshatch 
DOTS Dots 

Circle 
Center marker 
Edge marker 

CIRCLE 

Diagonal line 
CURSOＲ Cursor 
NAME Program data name 
COLOR Color bar 
GRAY Gray scale 
BURST Burst 
WINDOW Window 
OPTI１ Optional pattern 1 
OPT2 Optional pattern 2 
R Red output 
G Green output 
B Blue output 
INV Inversion 

 
Pattern settings 
CHARA: Character pattern  
This button is used to set the character pattern. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Code The character code is set here. 
Format The format of the character pattern which has been set is selected here. 
Font The font size is selected here. 
Cell size The horizontal cell size (H) and vertical cell size (V) are selected here. 

 



 
 
CROSS: Crosshatch pattern  
This button is used to set the crosshatch pattern. 
The crosshatch pattern is always displayed after the screen center has been calculated. The screen center can be 
calculated when the number of display dots and number of display lines are odd numbers. However, when they are 
even numbers, the actual screen center will be one dot to the right and one line below the center. An error results when 
0 is set for both H and V. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mode Specification as a number of lines (line) or dot intervals (dot) is selected here as 
the mode setting. 

Format The save start point (From Center or From Top Left) is selected here. 
Interval The number of lines (when "line" has been selected) or the dot interval (when 

"dot" has been selected) of the crosshatch  pattern is set here. 
Width The width of the drawn lines is set here. 
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DOTS: Dot pattern  
This button is used to set the dot pattern. 
The dot pattern is always displayed after the screen center has been calculated. The screen center can be calculated 
when the number of display dots and number of display lines are odd numbers. However, when they are even numbers, 
the actual screen center will be one dot to the right and one line below the center. An error results when 0 is set for both 
H and V. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mode Specification as a number of lines (line) or dot intervals (dot) is selected here 
as the mode setting. 

Format The save start point (From Center or From Top Left) is selected here. 
Interval The number of lines (when "line" has been selected) or the dot interval (when 

"dot" has been selected) of the dot pattern is set here. 
Dot size The dot size is set here. 
Dot type The type of dots is set here. 

 



 
 
CIRCLE: Circle pattern  
This button is used to set the circle pattern. 
The number of circles, etc. can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

Format This is selected on the basis of the data which has been set. 
Aspect The aspect ratio of the monitor is set here. The ratio is considered 

to be 1:1 when 0 is used for H or V setting. 
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CURSOR: Cursor pattern  
This button is used to set the cursor pattern. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Format The shape of the cursor is selected here. 
Flicker The flicker setting is selected here. 
Position (PosDisp) The method of displaying the cursor position is selected here. 
Step The cursor movement step is selected here. 
Color The RGB values of the cursor are selected here. 
Background Color The RGB values of the background color are selected here. 



 
 
COLOR: Color bar pattern  
This button is used to set the color bar pattern. 
The color bar pattern is always drawn in accordance with the interval provided and from the top left corner toward the 
screen center. This interval setting is used for both color bar and gray scale. 

 

 

 

 

 

 

 

 

 

 

 

 

Mode The interval setting increment (specified as a percentage or dot number) is 
selected here. 

Interval The horizontal (H) width and vertical (V) width are selected here. 
Direction The layout direction is selected here. 
Chapter 5 Repeat The color values from 0 to repeat are set here when level values are to be used 

repeatedly. 
Color The RGB values are set here. 
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GRAY: Gray scale pattern  
This button is used to set the gray scale pattern. 
When the analog mode or Tri-Sync has been selected as the output condition "Mode" setting, "Level" can be set; when 
the TTL mode has been selected, "Color" can be set. 
The gray scale pattern is always drawn in accordance with the interval provided and from the top left corner toward the 
screen center.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Mode The interval setting increment is selected here. 
Direction The layout direction is selected here. 
Repeat The color values from 0 to repeat are set here when level values are to be used 

repeatedly. 
Interval The interval between the shades of gray is set here. 

When the analog mode or Tri-Sync has been selected as the output condition "Mode" setting: 
Level : The gray display levels are set here. 

When the TTL mode has been selected as the output condition "Mode" setting: 
Color : The halftone levels are set here. 
 

* 8bit or 10bit can be selected in VG-835.  The level can be set between 0 to 255 in 8 bit mode, 0 to 1023 in 10 
bit mode. 
 
* 8bit , 10bit and 12bit can be selected in VG-835-A.  The level can be set between 0 to 255 in 8 bit mode, 0 to 
1023 in 10 bit mode, 0 to 4095 in 12 bit mode. 
 



 
 
BURST: Burst pattern  
This button is used to set the burst pattern. 

 

 

 

 

 

 

 

 

 

 

 

 

Format The drawing start point is selected here. 
Step The increment for the thickness of the vertical lines is selected here. 
Interval The number of vertical lines of the same thickness which are to be displayed 

is selected here. 
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WINDOW: Window pattern  
This button is used to select the window pattern. 
When the analog mode or Tri-Sync has been selected as the output condition "Mode" setting, "Analog Color" can be 
set; when the TTL mode has been selected, "TTL Color" can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mode The size setting increment (specified as a percentage or dot number) is selected 
here. 

Size The horizontal size (H) and vertical size (V) are selected here. 
Format The window already set is selected here. 
Flicker The scroll speed is selected here. 

* The "Flicker Level" button becomes effective if it is set in 4Level and 
16Level.  Then, each set screen is displayed. 

Flicker Level 
button 

Setting screen of Window 4Level Flicker and Window 16 Level Flicker is displayed.

 
When the analog mode or Tri-Sync has been selected as the output condition "Mode" setting: 

Analog RGB : The window colors are set here. 
When the TTL mode has been selected as the output condition "Mode" setting: 

TTL Color : The Video and halftone values are set here. 
 
* 8bit or 10bit can be selected in VG-835 and VG-857.  The level can be set between 0 to 255 in 8 bit mode, 0 to 
1023 in 10 bit mode. 
 
* 8bit , 10bit and 12bit can be selected in VG-835-A , VG-849C and VG-859C.  The level can be set between 0 to 
255 in 8 bit mode, 0 to 1023 in 10 bit mode, 0 to 4095 in 12 bit mode. 
 



 
 
WINDOW: Window 4Level Flicker 
Set the value of Window 4 Level Flicker.  Window level can be set 4-level.  Each level can output in the setting time (V 
unit). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Time The flicker time is set. 0 to 255 v 
Level The flicker level is set. 0 to 255 
Close The Window 4Level Flicker setting screen is ended, and it returns to the Window  

setting screen. 
 
 
* 8bit or 10bit can be selected in VG-835.  The level can be set between 0 to 255 in 8 bit mode, 0 to 1023 in 10 
bit mode. 
 
* 8bit , 10bit and 12bit can be selected in VG-835-A.  The level can be set between 0 to 255 in 8 bit mode, 0 to 
1023 in 10 bit mode, 0 to 4095 in 12 bit mode. 
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WINDOW: Window 16Level Flicker 
Set the value of Window 16Level Flicker.  Window level can be set 16-level.  Each level can output in the setting time 
(V unit). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Time The flicker time is set. 0 to 255 v 
Level The flicker level is set. 0 to 255 
Close The Window 16Level Flicker setting screen is ended, and it returns to the Window  

setting screen. 
 
 
* 8bit or 10bit can be selected in VG-835.  The level can be set between 0 to 255 in 8 bit mode, 0 to 1023 in 10 
bit mode. 
 
* 8bit , 10bit and 12bit can be selected in VG-835-A.  The level can be set between 0 to 255 in 8 bit mode, 0 to 
1023 in 10 bit mode, 0 to 4095 in 12 bit mode. 
 
 
 
 
 
 



 
 
OPT: Optional pattern 
This is used to set the optional patterns. 
When an optional pattern is set, no other patterns can be superimposed onto it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Option 1 (OPT1) The hexadecimal code of the optional pattern is set here. 
Option 2 (OPT2) The hexadecimal code of the optional pattern is set here. 
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NAME: Program data name 
This is used to display the name of the program data displayed. 
A new program data name can be set by inputting the name into "Program Name" of the program data name setting tab 
on the pattern data setting screen and saving it or sending it to the VG. The same procedure is adopted for changing a 
name. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
GRAPHIC: Graphic color 
This is used to set the graphic colors. 
When the analog mode or Tri-Sync has been selected as the output condition "Mode" setting, "Analog Color" can be 
set; when the TTL mode has been selected, "TTL Color" can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the analog mode or Tri-Sync has been selected as the output condition "Mode" setting: 
Analog color : The RGB values are set here. 

When the TTL mode has been selected as the output condition "Mode" setting: 
TTL Color : The TTL color values are set here. 

 

Background ON or OFF is selected here. 
Background Color The RGB values of the background color are set here. 

 

* 8bit or 10bit can be selected in VG-835.  The level can be set between 0 to 255 in 8 bit mode, 0 to 1023 in 10 
bit mode. 
 
* 8bit , 10bit and 12bit can be selected in VG-835-A.  The level can be set between 0 to 255 in 8 bit mode, 0 to 
1023 in 10 bit mode, 0 to 4095 in 12 bit mode. 
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■ Action data setting screen 

Pull-down scroll 

Action data setting screen 

 

 

Action data setting screen 
Click the check box to the left of the action data type to be set to check it. The setting items for each type can now be 
selected. 
 
Pull-down scroll 
Scrolling can be simulated by employing the 2-3 pull-down function and other scroll functions. 
 
2-3 pull down function 
This is a conversion method for ensuring the coordination of 30 fps/60-field NTSC signals with 24 fps films when 
converting regular movies and other film sources into video signals. The first frame of the film is converted into the 
equivalent of 2 fields and the second frame into the equivalent of 3 fields, and the resulting 5-field format for every 2 film 
frames is repeated so that 24 frames are converted into 60 fields. DVD players which support a progressive output 
capability can detect this 2-3 pull-down processing information and reproduce the 24 original frames. However, a TV 
monitor which supports the progressive system must be used for playback. 
 
 



 
 
Pattern pull-down scroll setting screen 

 

Interval2 The interval from 0 to 999V is set here. 
Interval3 The interval from 0 to 999V is set here. 
Interval4 The interval from 0 to 999V is set here. 

Pattern 
H‐Step2 The number of steps from 0 to 4095 dots is set here. 
H‐Step3 The number of steps from 0 to 4095 dots is set here. 
H‐Step4 The number of steps from 0 to 4095 dots is set here. 
V‐Step2 The number of steps from 0 to 4095 dots is set here. 
V‐Step3 The number of steps from 0 to 4095 dots is set here. 
V‐Step4 The number of steps from 0 to 4095 dots is set here. 

Window 
Step2 The number of steps from 0 to 255 dots is set here. 
Step3 The number of steps from 0 to 255 dots is set here. 
Step4 The number of steps from 0 to 255 dots is set here. 

 
 
 

 
 

40



Chapter 2 Operation
 

 
 

41

Setting ranges 
 

Action interval Action Interval 1 to 999 V 
 Interval2 0 to 999 V 
 Interval3 0 to 999 V 
 Interval4 0 to 999 V 
Character flicker  ON/OFF 
Window flicker  ON/OFF 

Character Scroll 
 

Left, Right, Up, Down, LeftUp, 
RightUp, RightDown, Moving 

Graphic Scroll Left, Right, Up, Down, LeftUp, 
RightUp, RightDown, Moving 

H�Repeat 1 to 15 
V�Repeat 1 to 15 
H�Step 1 to 4096 dots 
V�Step 1 to 4096 dots 
H�Step2 0 to 4096 dot 
V�Step2 0 to 4096 dot 
H�Step3 0 to 4096 dot 
V�Step3 0 to 4096 dot 
H�Step4 0 to 4096 dot 

Pattern scroll 

V�Step4 0 to 4096 dot 
 Left, Right, Up, Down, LeftUp, 

RightUp, RightDown, Moving 
Step 1 to 255 dot 
Step2 0 to 255 dot 
Step3 0 to 255 dot 

Window scroll 

Step4 0 to 255 dot 
Palette scroll PalNo.1 0 to 255 
 PalNo.2 0 to 255 
 Step -128 to 127 

 

 



 
 

■ Audio data setting screen 

Frequency settings Sweep Mode settings 

 

 

Sweep Mode 
"Sweep OFF," "Frequency," "LEVEL(L)" or 
 
Frequency 
The frequency is set in the LEFT and RIGHT fields
Any frequency from 100 to 20,000 Hz can be set in
The settings are performed in 100 Hz increments. 
 
Level 
The level is set in the LEFT and RIGHT fields. 
Any level from 0 to 2000 mV can be set in each fie
The settings are performed in 50 mV increments. 
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Level settings
"LEVEL(R)" is selected as the Sweep Mode setting. 

. 
 each field. 

ld. 
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■ HDMI data setting screen 
 

※A setting screen is a thing at the time of VG-849 selection. 
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④

 

 

⑤

⑥

⑦
 ⑧
 ⑨
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No. Item name Details 
① HDMI Mode Set HDMI output mode. Select from OFF, HDMI, HDMI1.1, DVI, or AUTO. 

② 

Video ・Video Fomat 
Select the video format.  Select from RGB, Y444, Y422_16, Y422_20, or 
Y422_24. 
・Video Level 

Set the format of the video level.  Select from Full range, Limited range, or USER.  
If “USER” is selected, it is possible to input setting range by video format.  
RGB, Y444, Y422_16 = 0 to 255 
Y422_20 = 0 to 1023 
Y422_24 = 0 to 4095 

③ 

Audio ・Audio Source  
Select the output signal of the HDMI standard.  Select from OFF, TOSLINK, 
COAX, ANALOG or INTERNAL. 
・Audio Sample Freq 

Set the frequency.  Select from 32kHz, 44.1kHz, 48kHz, 88.2kHz, 96kHz, 176.4kHz, or 
192kHz. 
・Audio Width 
Set the audio bit width.  Select from 16bit, 20bit or 24bit. 
・Audio Internal Sweep  
Set the internal Sweep.  Select from OFF or Freq. 
・Audio Internal L-R Level 

Set the audio output level.  The max value differs by the setting of AudioWidth 
item. 
16bit : 7FFF 
20bit : 7FFFF 
24bit : 7FFFFF 
・Audio Internal L-R Freq 

Set the output frequency.  The max value differs by the setting of 
AudioSampleFreq item. 
32kHz : 10kHz 

44.1kHz : 22.05kHz 

48kHz : 24kHz 
④ YPbPr Matrix Set the value of YPbPr.  Input the appropriate number. 
⑤ SyncPolarity Display NEGA and POSI that is set in the part of “OUTPUT”. 
⑥ Repetition Set the value of the Repetition.  Set among 1 to 10. 

⑦ InfoFrame Setting 
button 

InfoFrame setting screen is displayed. 

⑧ ACP Setting button ACP setting screen is displayed. 
⑨ AFD Setting button AFD setting screen is displayed. 
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■ InfoFrame data setting screen 
 

※A setting screen is a thing at the time of VG-849 selection. 
 

 

② ① 
 

 

 

 

 

 

 

 

 

 

③  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

④  

 

 

 

 

 

 

 

 

 
 
 
 
 



 
 
 
No. Item name Details 
① AVI ON/OFF 

Select ON or OFF of InfoFrameAVI. 
Type 
Display the type of InfoFrameAVI. 
Version 
Set the version of InfoFrameAVI. Select either 1 or 2. 
ScanInfo 
Set the ScanInfo.  Select from NoData, Overscanned, or Underscanned. 
BarInfo 
Set about the BarInfo.  Select from NotValied, Vert, Horiz or Vert&Horiz. 
Scaling 
Set about the Scaling.  Select from unknown, Vert, Horiz or Vert&Horiz. 
ActiveFormatInfo 
Set about the ActiveFormatInfo. Select either NoData or Valid. 
RGB/YCbCr 
Set either RGB or YcbCr.  Select from RGB, YCbCr422 or YCbCr444. 
ActiveAspectRatio 
Set the active aspect ratio.  Select from Same, 4:3, 16:9 or 14:9. 
PictureAspectRatio 
Set the picture aspect ratio.  Select NoData, 4:3 or 16:9. 
Colorimetry 
Set about the Colorimetry.  Select from NoData, SMPTE, or ITU709. 
VideoCode 
Set the VideoCode.  Select between 0 and 34 
Repetition 
Set about the Repetition.  Select between 1 and 10. 
End of Top Bar 
Set the Top Bar.  Select between 1 and 65535. 
Start of Bottom Bar 
Set the Bottom Bar.  Select between 1 and 65535. 
End of Left Bar 
Set the Left Bar.  Select between 1 and 65535. 
Start of Right Bar 
Set the Right Bar.  Select between 1 and 65535. 

② SPD ON/OFF 
Select ON or OFF of InfoFrameSPD. 
Type 
Display the type of InfoFrameSPD. 
Version 
Set the version of InfoFrameSPD.  One version is fixed. 
VendorName 
Set the VendorName.  Input using ASCII letters. 
ProductDescript 
Set the ProductDescript.  Input using ASCII letters. 
SourceDevice 
Set the SourceDevice.  Select from unknown, DigiSTB, DVD, DVHS, HDD, DVC, 
DSC, CD, Game or PC. 

③ Audio ON/OFF 
Select ON or OFF of InfoFrameAudio. 
Type 
Display the type of InfoFrameAudio. 
Version 
Set the version of InfoFrameAudio.  One version is fixed. 
Channel Count 
Set the channel counting.  Select from Refer, 2ch, 3ch, 4ch, 5ch, 6ch, 7ch or 8ch. 
CodingType 
Set the coding type.  Select from Refer, IEC60958, AC3, MPEG1, MP3, MPEG2, 
AAC, DTS or ATRAC. 
SampleSize 
Set the sampling size.  Select from Refer to stream, 16bit, 20bit or 24bit. 
SampleFreq 
Set the sampling frequency.  Select from Refer to stream, 32kHz, 44.1kHz, 48kHz, 
88.2kHz, 96kHz, 176.4kHz or 192kHz. 
Channel/Speaker Allocation 
Set the speaker channel.  Set between 0 and 31. 
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LevelShift 
Set the level shift.  Set between 0 and 15. 
Down-mixInhibit 
Select “Permitted” or “Prohibited” of using DownMix. 

④ MPEG ON/OFF 
Select ON or OFF of InfoFrameMPEG. 
Type 
Display the Type of InfoFrameMPEG. 
Version 
Set the version of InfoFrameMPEG.  One version is fixed. 
BitRate 
Set the BitRate within the range of 0 to 4294967295.  
(4294M967K295Hz) 
Frame 
Set about the Frame.  Select from unknown, I Picture, B Picture or P Picture. 
FieldRepeat 
Set about FieldRepeat.  Select either New or Repeated. 

 

 

 

 



 
 

■ ACP data setting screen 
 

※A setting screen is a thing at the time of VG-849 selection. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Item name Details 
① ACP Packet ON/OFF 

Select ON or OFF of ACP. 
ACP Type 
ACP type setup. Please make a selection from Generic Audio, IEC60958, DVD 
Audio, or Reserved for SACD. 
DVD-Audio Type Dependent Generation 
DVD-Audio Type Dependent Generation setup. Only one way to choose. 
Copy Permission 
Copy Permission setup. Please make a selection from 0, 1, 2, or 3. 
* When ACP Type is set to DVD Audio, it can be selected. 
Copy Number 
Copy Number setup. Please make a selection from 0, 1, 2, 3, 4, 5, 6, or 7. 
* When Copy Permission is set to 2, it can be selected. 
Quality 
Quality setup. Please make a selection from 0, 1, 2, or 3. 
* When Copy Permission is set to two, it can be selected. 
Transaction 
Transaction setup. Please make a selection from 0 or 1. 
* When Copy Permission is set to two, it can be selected. 
Count_A 
Count_A setup. Please make a selection from 0 to 255. 
Count_S 
Count_S setup. Please make a selection from 0 to 255. 
Count_U 

③ 

② ① 
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Count_U setup. Please make a selection from 0 to 255. 
Q_A 
Q_A setup. Please make a selection from 0 or 1. 
Q_S 
Q_S setup. Please make a selection from 0 or 1. 
Q_U 
Q_U setup. Please make a selection from 0 or 1. 
Move_A 
Move_A setup. Please make a selection from 0 or 1. 
Move_S 
Move_S setup. Please make a selection from 0 or 1. 
Move_U 
Move_U setup. Please make a selection from 0 or 1. 

② ISRC 1 ON/OFF 
Select ON or OFF of ISRC1. 
ISRC Cont 
ISRC Cont setup. Please make a selection from either 0 or 1. 
ISRC Valid 
ISRC Valid setup. Please make a selection from either 0 or 1. 
ISRC Status 
ISRC Status setup. Please make a selection from Starting, Intermediate, or Ending. 
Validity Information 
Validity Information setup. Please make a selection from No Validity, ISRC, 
UPC/EAN, or UPC/EAN&ISRC. 
Catalogue Code（UPC/EAN #1-#13） 
Catalogue Code setup. Please setup using only 13 characters. 
Country Code（ISRC #1-#2） 
Country Code setup. Please setup using only 2 alphanumeric characters. 
First owner Code（ISRC #3-#5） 
First owner Code setup. Please setup using 3 alphanumeric characters. 
Year of Recording  Code（ISRC #6-#7） 
Year of Recording Code setup. Please setup using 2 characters. 
Recording （item） Code（ISRC #8-#12） 
Recording (item) Code setup. Please setup using 5 characters. 

③ ISRC 2 Select ON or OFF of ISRC2. 

 
 
 
 



 
 

■ CEC data setting screen 
 

※A setting screen is a thing at the time of VG-849 selection. 

 
 
 

①  
 
 

② ③ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

④  
 
 
 
No. Item name Details 
① CEC Mode setting  Set CEC Mode. 

Select among “Monitor”, “Sending” and “Respond”. 
② VG Logical Address VG Logical Address 

From which device the command is transmitted is set. Set the value from 0 to F. 
* VG Logical Address and TX Initiator are adjusted each other. When either 
value is changed, the other set value is changed.  

③ Transmission 
command is set 
 

TX Initiator 
From which device the command is transmitted is set. Set the value from 0 to F. 
* VG Logical Address and TX Initiator are adjusted each other. When either 
value is changed, the other set value is changed. 
TX Destination 
To which device the command is transmitted is set. Set the value from 0 to F. 
Op Code 
Set Op Code of the command. Set the value from 00 to FF. 
ParameterNum 
Set the number of Parameter. Set the value from 0 to 14. 
Parameter 
Set the number of Parameter. Set the value from 00 to FF in each Parameter. 

④ Receiving command 
is set. 
 

RX Initiator 
From which device the command is transmitted is set. Set the value from 0 to F. 
RX Destination 
To which device the command is transmitted is set. Set the value from 0 to F. 
Op Code 
Set Op Code of the command. Set the value from 00 to FF. 
ParameterNum 
Set the number of Parameter. Set the value from 0 to 14. 
Parameter 
Set the number of Parameter. Set the value from 00 to FF in each Parameter. 
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■ ADF data setting screen 
 

※A setting screen is a thing at the time of VG-849 selection. 

 

The "EIA/CEA-861B standard" aspect ratio evaluation pattern can be set as optional pattern 1F.  The detailed settings 
of optional pattern 1F are shown below. 

 

Aspect Mode 
For setting the actual aspect ratio. 
 
AFD Aspect 
For setting CodeFrame of the AFD which is defined by the EIA/CEA-861B standard. 
 
AFD Type 
For setting the number of the AFD which is defined by the EIA/CEA-861B standard. 
 
AFD Color 
For setting the color used for the circle of the optional pattern 1F. 
 
AFD BG 
For setting the color of the background used for the circle of the optional pattern 1F. 
 
AFD Bar 
For setting the color of the SideBar and LetterBox of the optional pattern 1F. 
 



 
 

■ ClosedCaption/V-chip data setting screen 

ClosedCaption 

V-chip 

 

 

V-chip 
V-chip data is set up. Please refer to a "2.18. ClosedCaption/V-chip data transmission tool" for details. 
 
ClosedCaption 
Caption data is set up. Please refer to a "2.18. ClosedCaption/V-chip data transmission tool" for details. 
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■ Teletext data setting screen 

Page 

Execute Line 

 

 
Execute 
Select ON or OFF for the output 
 
Line 
Set the teletext data transmission mode. 
･4line : Four lines are set as the mode for transmitting the teletext data. 
       Display lines : Field1 = 20, 21. Filed2 = 333, 334 
･8line : Eight lines are set as the mode for transmitting the teletext data. 
       Display lines : Field1 = 13, 14, 20, 21. Field2 = 326, 327, 333, 334 
 



 
 
Page 
This is used to set the pages for each of the channels. The contents of a page are as being shown below. 
If a page with any other number is set, only the page number will be displayed. 
 

Page Contents 
100 Index Page 
101 Test Page 
102 Newsflash 
103 Subtitle 
200 Character Set(English) 
201 Character Set (German) 
202 Character Set (Swedish/Finnish/Hungarian)
203 Character Set (Italian) 
204 Character Set (French) 
205 Character Set (Portuguese/Spanish) 
206 Character Set (Czech/Slovak) 
301 Colours 
302 White Flat 
505 Clock Cracker 
515 Multi Page 
555 Test Pattern1 
560 Test Pattern2 
580 Test Pattern3 
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■ Macrovision data setting screen 

Macrovision Mode 

 

 
Mode 
The output mode of a Macrovision is set up. The modes which can be set up for every setting timing differ. 
 



 
 
The mode which can be set up for every timing. 

 
Timing Mode 

OFF 
DVD/STB Type 1 
DVD/STB Type 2 
DVD/STB Type 3 
VHS USA 

NTSC-M 

VHS US obs. 
OFF 
DVD/STB Type 1 
DVD/STB Type 2 
DVD/STB Type 3 
VHS Japan 1 

NTSC-J 

VHS Japan 2 
OFF NTSC-443 
DVD/STB 
OFF PAL-60 
DVD/STB 
OFF PAL-M 
DVD/STB 
OFF 
DVD/STB 

PAL 

VHS 
OFF 
DVD/STB 

PAL-N 

VHS 
OFF 
DVD/STB 

PAL-Nc 

VHS 
OFF 
DVD/STB 

SECAM 

VHS 
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■ IA-575 data setting screen 

Pattern settingTiming setting ScartOutput setting 

 
 
ScartOutput 
The IA-575 can switch its output signals to VBS output, Y/C output or RGB output signals. 
 
Timing 
When a timing system other than one supported by the IA-575 has been selected, it is possible to specify the timing 
system which are to be output from the IA-575. 
 
Pattern 
When a timing system other than one supported by the IA-575 has been selected, it is possible to specify the pattern 
which are to be output from the IA-575. 
 
 



 
 

2.6. Creating and editing the user characters 
 

This section describes how the VG's user characters (hereafter referred to as the "characters")
are set. The VG characters can be created and edited, edited characters can be sent to the VG
and registered on the panel ROM or memory card, and characters from the VG can be received.

 

 

2.6.1. Startup method 
Click the [Char] button of "VGBase" to start up the "Character Editor." 

2.6.2. Window screen and description 
 
 

⑦ 

⑥ 

⑤ 

④ 

③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Item name Details 

① Code The codes of the characters registered in the VG appear here. 
② Zoom These buttons are used to enlarge or reduce what is displayed inside the editing 

area. 

  ： This is used to enlarge what is displayed inside the editing area. 

  ： This is used to reduce what is displayed inside the editing area. 
③ All Clear This button is used to clear the entire character in the editing area. 

④ Cell Size The editing area cell size can be set here. Either select the size from Auto of the 
radio button or set a customized size. 

⑤ Mouse Position The position of the mouse inside the editing area appears here. 
⑥ Undo This button is used to undo the last operation. 
⑦ Editing area Position the mouse cursor in the editing area. If the right button is now clicked, 

the mouse cursor position is filled in with black; if the left button is clicked, it is 
filled in with white. This position corresponds to one dot of the character font. In 
this way, characters can be created visually. 
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2.6.3. Operation methods 
(1)Loading the file 
Before creating new characters, proceed with "Creating and editing the character data" in 2) below. 

1) Press the [Load] button to open the "Load File" file selection dialog box. 
2) Select the file. When [Display Image] is checked, the selected file is previewed. 
3) Click the [OK] button. The character of the selected file is now displayed in the editing area. 
¾ If the layout has been set 

The character code registered in the layout is displayed at [Code]. 
¾ If the layout has not been set 

[Code] is cleared. 
 

(2)Creating and editing the character data 
1) If the grid section of the editing area is clicked with the right button of the mouse, it is set to ON; if it is clicked with 

the left button, it is set to OFF. (One grid section in the editing area corresponds to one dot of the character font. In 
the editing area, the ON state is indicated in black and the OFF state in white.) 

2) To set a multiple number of consecutive dots, drag the mouse and all the dots of the character along the line of 
movement will be set to ON if the right button of the mouse is clicked and to OFF if the left button is clicked. 

3) To clear the entire character created in the editing area, click the [All Clear] button. 
4) To undo the last operation, click the [Undo] button. 
(*) The numbers shown by [Cell Size] serve as a general guideline when editing by changing the line color of the set 

position. 
(*) The position of the cursor in the editing area is indicated at [Mouse Position]. 
 

(3)Loading the Windows font data 
The font data already installed in Windows is converted into the character format and loaded. 

1) Click the [Win Font] button. The "Select Windows Font" font selection dialog box appears. 
2) Specify the text to be loaded in [Text]. 
3) To change the text font, size or style, click the [Set Font...] button. 
4) To change the position or size of the text display, use [Start Position] or [Size]. 
5) To specify alignment of the text position, use [Align]. 
6) Click the [OK] button. The specified text is now displayed in the editing area. 
 

(4)Saving the file 
The displayed data is saved in the file. 
Click the [Save] button. → The data is saved in the selected file and any existing data in that file is overwritten. 
Click the [Save As] button. → The data is saved in a new file. 
(*) If [Display Image] is checked, the selected file is previewed. 
 



 
 
(5)Sending the characters 

1) Click the [Send] button. The "Send to VG" code selection dialog box appears. 
2) Set the character code (0xE0 to OxEF in hexadecimal format). 
3) Click the [OK] button. The character is now sent to the VG and registered. (The code shown at [Code] now 

changes to that of the sent character.) 
(6)Receiving the characters 

1) Click the [Receive] button. The "Receive from VG" code selection dialog box appears. 
2) Set the character code (0xE0 to OxEF in hexadecimal format). 
3) Click the [OK] button. The reception of the character is now started. 
4) The received character is displayed in the editing area. (The code shown at [Code] now changes to that of the 

received character.) 

 

(7)Printing
1) Click 
2) The "
3) Click 
4) To ch
5) The p

box a
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Characters can be received from old VG model but they cannot be sent to one.
 

 the characters 
the [Print] button to print the characters which have been created. 
Print" dialog box appears. Set the margins here. 
the [OK] button. The displayed character is now printed. 
ange the printer which has been set, click the [Set Printer...] button. 
rinter setting dialog box appears. Proceed with the printer settings. For details on how the items on this dialog 
re set, refer to the instruction manual for Windows or for the printer which will be used. 
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2.7. Creating and editing the group data 
 

This section describes how the VG's group data is set. The VG group data can be created and 
edited, edited group data can be sent to the VG and registered on the panel ROM or memory 
card, and group data from the VG can be received. Different program display screens are 
displayed depending on the VG model which is connected. 

2.7.1. Startup method 
Click the [Group] button of "VGBase" to start up the "Group Editor." 

2.7.2. Window screen and description 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

⑦ 

⑥ 

⑤ 

④ 

③ 
② ① 

 



 
 
 

No. Item name Details 

① No The number of the group data registered in the VG appears here. 
② Neme The name of the group data registered in the VG appears here. 
③ Edit When this button is clicked, the "Program Layout Editor" program data 

registration dialog box appears. 
④ Group The loaded program data is displayed here. 

⑤ Cell editing buttons ● ↑, ↓: The [up] button and [down] button enable the group data to be 
scrolled up and down. 

● [Insert]: This button makes it possible to scroll down all the lines below the 
one selected and insert a blank line. 

● [Delete]: This button is used to delete lines. The group data below a 
deleted line moves up to fill the gap left. 

● [Clear], [All Clear]: These buttons are used to delete the group data. 
⑥ Program in Layout The program data registered in the layout is displayed here. 
⑦ Set This button is used to register the data, which is displayed on the program data 

list, onto the group data list. 
 

2.7.3. Operation methods 
(1)Loading the file 
Before creating new group data, proceed with "Creating and editing the group data" in 2) below. The group data is 
loaded from one of the files which have been saved. 

1) Press the [Load] button to open the "Load from File" file selection dialog box. 
2) Select the file, and click the [OK] button. 
3) The data of the selected file is now displayed on the [Group] group data list. 
¾ If the layout has been set 

The number of the group data registered in the layout is displayed at [No.]. 
¾ If the layout has not been set 

[No.] is cleared. 
 

(2)Creating and editing the group data 
1) When the "Group Editor" is started up, the program registered in the layout is displayed on the [Program in Layout] 

program data list. 
2) Select the program data to be registered from [Program in Layout]. 
3) Select the line to be set from among the lines on the [Group] group data list, and click the [<-] (left arrow) button. 

The program data number ([No.]) and program name ([Prg Name]) are set and displayed on the line selected in 
[Group]. (When a multiple number of programs has been selected, lines for the data to be registered are added 
below the line selected on the group data list.) 

4) Change the group data which has been set in [Group]. 
To move the group data up or down, click the [up] or [down] button. 
¾ To delete the group data, click the [Clear] button or [All Clear] button. 
¾ Use the [Delete] button to delete a line, after which the group data below the deleted line moves up to fill the 

gap left. 
(*) If no data files in the layout have been loaded, no programs are displayed in [Program in Layout]. Input and set only 
the program data numbers. As above, select the line in [Program in Layout], and click the [<-] button. Only the program 
data number is now set. Alternatively, using the mouse, click the [No.] field of the group data list where the program data 
number is to be input. The number can be keyed in. 
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(3)Saving the file 
The displayed data is saved in the file. 
Click the [Save] button. → The data is saved in the selected file and any existing data in that file is overwritten. 
Click the [Save As] button. → The data is saved in a new file. 
(*) The group data name can be set by inputting it into [Name] of the "Group Editor."  This name is stored in the file 
when a panel ROM is used but it will not be sent to the VG. 
 
(4)Sending the group data 

1) Click the [Send] button. The "Send to VG" code selection dialog box appears. 
2) Set the group number (1 to 99). 
3) Click the [OK] button. The group data is now sent to the VG and registered. (The number of the data sent now 

replaces the previous number appearing in [No.].) 
4) The group data name can be set by inputting it into [Name] on the group data setting tab of the group data setting 

window. This name is stored in the file when a panel ROM is used but it will not be sent to the VG. 
 

(5)Receiving the group data 
1) Click the [Receive] button. The "Receive from VG" number selection dialog box appears. 
2) Set the group number (1 to 99). 
3) Click the [OK] button. The reception of the group data is now started. (The number of the received group data now 

replaces the previous number appearing in [No.].) 
(*) When program data is received from the panel ROM (HN58C65P only), it has a 2-digit number. 
 

Group data can be received using an old VG model but it cannot be sent to one. 

 

(6)Printing the group data 
1) Click the [Print] button to print the group data which has been created. 
2) The "Print" dialog box appears. Set the margins here. 
3) Click the [OK] button. The displayed data is now printed. 
4) To change the printer which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. Proceed with the printer settings. For details on how the items on this dialog 

box are set, refer to the instruction manual for Windows or for the printer which will be used. 
 

(7)Registering the program 
The program data files in the directory are registered on the layout data list. (If layout data files have not been loaded, 
they cannot be registered.) 

1) Click the [Edit] button. 
2) The "Program Layout Editor" program data registration dialog box appears. For details on the registration method, 

refer to "Selecting and editing the layout data files" in Section 3-11. 



 
 

2.8. Creating and editing the auto display data 
 

This section describes how the VG's auto display data is set. The VG auto display data can be 
created and edited, edited auto display data can be sent to the VG and registered on the panel 
ROM or memory card, and auto display data from the VG can be received. 

2.8.1. Startup method 
Click the [Auto Disp] button of "VGBase" to start up the "Auto Display Editor." 

2.8.2. Window screen and description 
 

⑦ 

⑥ 

④ 

⑤ 

③ 

② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Item name Details 

① Neme The name of the auto display data is set here. 
② Auto Display The auto display data which has been set is displayed here. 
③ All Clear/Clear These buttons are used to clear the program data on the auto display data 

list. 
④ Interval The interval of the auto display data is set here. 
⑤ Edit When this button is clicked, the "Program Layout Editor" program data 

registration dialog box appears. 
⑥ Program in Layout The program data registered in the layout is displayed here. 
⑦ Set This button is used to register the selected program data on the [Auto 

Display] line selected. 
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2.8.3. Operation methods 
(1)Loading the file 
Before creating new auto display data, proceed with "Creating and editing the auto display data" in (2) below. 
The auto display data is loaded from a file in which it was saved. 

1) Click the [Load] button. The "Load File" file selection dialog box now appears. 
2) Select the file, and click the [OK] button. The auto display data of the selected file is now displayed on the [Auto 

Display] auto display data list. 
 

(2)Creating and editing the auto display data  
1) Select the program data to be set from the [Program in Layout] program data list. 
2) Before proceeding any further, select the line on the [Auto Display] auto display data list to be set for registering the 

data. 
3) Click the [←] button, and register the selected program data on the [Auto Display] line selected. 
¾ To clear the auto display data, click the [Clear] button or [All Clear] button. 

4) Set the number of interval seconds in [Interval]. 
(*) If no data files in the layout have been loaded, no programs are displayed in [Program in Layout]. Input and set 

only the program data numbers. As above, select the line in [Program in Layout], and click the [←] button. Only the 
program data number is now set. Alternatively, use the mouse to click the [No.] field of the auto display data list 
where the program data number is to be input. The number can now be keyed in. 

(*) In registering the auto display data, set the program data for both [Start] and [End]. Set the program data from the 
top without leaving any gaps. (In other words, do not enter a setting for [Start] or [End] only or leave any blank lines 
between data settings.) 

 
(3)Saving the file 

The displayed data is saved in the file. 
Click the [Save] button. ⇒ The data is saved in the selected file and any existing data in that file is overwritten. 
Click the [Save As] button. ⇒ The data is saved in a new file. 
(*) The auto display data name can be set by inputting it into [Name] of the "Auto Display Editor." This name is stored 

in the file but it will not be sent to the VG. 
 

(4)Sending the auto display data  
When the [Send] button is clicked, the sending of the auto display data is started. The name which was input in 
[Name] is stored in the file but it will not be sent to the VG. 
 

(5)Receiving the auto display data  
Click the [Receive] button. The auto display data is now received. [Name] is cleared since the name of the auto 
display data is not registered in the VG. 
(*) When auto display data is received from the panel ROM (HN58C65P only), it has a 2-digit number. 
 

Auto display data can be received using an old VG model but they cannot be sent to one. 
 



 
 
(6)Printing the auto display data  

1) Click the [Print] button. 
2) The "Print" dialog box appears. Set the margins here. 
3) Click the [OK] button. The displayed data is now printed. 
4) To change the printer which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. Proceed with the printer settings. For details on how the items on this dialog 

box are set, refer to the instruction manual for Windows or for the printer which will be used. 
 
(7)Registering the program 

The program data files in the data directory are registered on the layout data list. If layout data files have not been 
loaded, they cannot be registered. 
1) Click the [Edit] button. 
2) The "Program Layout Editor" program data registration dialog box appears. For details on the registration method, 

refer to "Selecting and editing the layout data files" in Section 3-11. 
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2.9. Converting the image data 
 

This section describes how the VG's image data is set. BMP data or JPG data can be 
converted into VBM data for use by the VG, VBM data can be sent to the VG and registered 
on the memory card, VBM data from the VG can be received, and this data can be saved as 
VBM files. 

 

2.9.1. Startup method 
Click the [Image] button of "VGBase" to start up the "Image Converter." 

2.9.2. Window screen and description 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

⑥ ⑤ ④ 

③ 

② ① 

 
No. Item name Details 
① No The number of the image data registered in the VG appears here. 
② Name The name of the image data displayed appears here. 
③ Image display window The image data is displayed here. 
④ Image type The displayed data image type is shown here. 
⑤ Image size The displayed data size is shown here. 
⑥ Number of image colors The number of colors of the displayed data is shown here. 

 
 



 
 

2.9.3. Operation methods 
(1)Loading the image file 

BMP files, JPG files and VBM files are loaded and displayed. 
1) Click the [Load] button. 
2) The "Load Image File" file selection dialog box is opened. Select the file type (BMP, JPG or VBM data), and select 

the file. If [Display Image] is checked, the selected file is previewed. 
3) Click the [OK] button to load the selected image file. 
¾ If the layout has been set 

In the case of a VBM file, the number of the VBM data registered in the layout is displayed at [No.]. In the case 
of any other type of file, [No.] is cleared. 

¾ If the layout has not been set 
[No.] is cleared. 
 

(2)Saving a VBM file 
The displayed data is saved as a VBM file. It cannot be saved as a BMP or JPG file. 
1) Click the [Save As] button. 
2) The "Save VBM File" file selection dialog box appears. 
3) Input the filename, and click the [OK] button. The displayed  VBM data is now saved in a new file. 
(*) The image data name can be set by inputting it into [Name]. 
 

(3)Sending the VBM data 
The displayed data is converted into VBM data and sent to the VG. 
1) Click the [Send] button. The "Send to VG" number selection dialog box appears. 
2) Set the number (1 to 64) or optional code (0x80 to OxBF). (Both of these are supported. When data is set in either 

the number or the code, the corresponding data will be set in the other.)  (The number of the sent VBM data now 
replaces the previous number appearing in [No.].) 

3) Click the [OK] button. The VBM data is now sent to the VG and registered. 
(*) The image data name can be set by inputting it into [Name] on the VBM display screen. 

 
(4)Receiving the VBM data 

The VBM data is received from the VG and displayed. 
1) Click the [Receive] button. The "Receive from VG" number selection dialog box appears. 
2) Set the number (1 to 64) or optional code (0x80 to OxBF). (Both of these are supported. When data is set in either 

the number of the code, the corresponding data will be set in the other.)  Click the [OK] button. 
3) The VBM data is received and displayed. (The number of the received VBM data sent now replaces the previous 

number appearing in [No.].) 
 

VBM data can be received using an old VG model but they cannot be sent 
to one. 

 
(5)Printing the image data 

1) Click the [Print] button. 
2) The "Print" dialog box appears. Set the margins here. 
3) Click the [OK] button. The displayed data is now printed. 
4) To change the printer which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. Proceed with the printer settings. For details on how the items on this dialog 

box are set, refer to the instruction manual for Windows or for the printer which will be used. 
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2.10. Creating and editing the optional patterns 
 

This section describes how the VG user-created optional patterns (hereafter abbreviated to 
"optional patterns") are set. The VG optional patterns can be created and edited, edited 
optional pattern source codes can be compiled, optional pattern data can be sent to the VG 
and registered on the memory card, and optional patterns from the VG can be received. 

2.10.1. Startup method 
Click the [Opt-Ptn] button of "VGBase" to start up the "Option Pattern Editor." 

2.10.2. Window screen and description 

■ Compilation screen 
 

④ 

③ 

② 
① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

No. Item name Details 
① Code The code registered in the layout data appears here. 
② Name The name of the displayed optional pattern appears here. 
③ Editing screen The source codes of the optional patterns are created, changed and 

displayed on this screen. 
④ Compiling screen Messages appear here during the compiling process. 

 
 

■ Simulation Window 
 
 
 
 
 

Caution If user option pattern data has different planes, such as 1-bit, 8-bit and Window plane, it takes 
certain amount of time to display Simulation Window. 

 
 
・Resolution Input screen 
By pressing “Exec” button, the Resolution Input screen is displayed. 
 
 
 
 

  
 
 
 
 
 
 
 
 

No. Item 
① Resolu

② Dot Cl

③ LUT v
and 86

④ OK bu
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④
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・Simulation screen 
 

⑤ ④ 

③ 

② 

①  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Description 
① Plane switching Simulated pattern can be displayed by each plane, such as 8-bit, Window, 

1-bit and Mix. 
② Output screen Simulated pattern is displayed. 
③ Compile screen Message for compiling is displayed. 
④ VBM data-izing button The pattern that is displayed in the output screen is made to be a file of 

256-color VBM data 
⑤ Close Close the Simulation screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

2.10.3. Operation methods 
(1)Loading the file 

Before creating new optional pattern data, proceed with "Creating and editing the optional patterns" in (2) below. The 
source code is loaded from a file which has already been saved. 
1) Click the [Load] button. 
2) The "Load File" file selection dialog box is opened. Select the file, and click the [OK] button. 
3) The source code of the selected file is now displayed in the editing area. 
¾ If the layout data has been set 

The code registered in the layout is displayed at [Code]. 
¾ If the layout data has not been set 

[Code] is cleared. 
 
(2)Creating and editing the optional patterns 

1) Load the source code into the editing area. For details on creating these codes, refer to "make_opt.txt" or to the 
"Help for creating optional patterns" (OptionPatternRef.Help). 

2) Click the [Compile] button to start compiling. 
3) When "Compile OK." appears on the compiling screen, it means that the compiling has been successfully 

completed. The optional pattern language, which is an intermediate language, is now created from the source 
code. 

4) To execute a simulation on the window screen, click the [Exec] button. A simulated image of the compiled optional 
pattern data is now displayed on the "Execute Image" simulation window. Check the operation. 

 
(3)Saving the file 

The displayed source code is saved in the file. 
Click the [Save] button. ⇒ The data is saved in the selected file and any existing data in that file is overwritten. 
Click the [Save As] button. ⇒ The data is saved in a new file. 

 
(4)Sending the optional pattern 

1) Click the [Send] button. The "Send to VG" code selection dialog box appears. 
2) Set the optional pattern code (0x40 to Ox7F in hexadecimal format). 
3) Click the [OK] button. The data is now sent to the VG and registered. (The code shown at [Code] now changes to 

that of the sent character.) 
(*) When [Set File Name] is checked, the dialog box for selecting the data to be sent is opened after the [OK] button 

has been clicked. By selecting the data, it is possible to send optional pattern data regardless of the optional 
pattern being edited. 

 
(5)Receiving the optional patterns 

1) Click the [Receive] button. The "Receive from VG" code selection dialog box now appears. 
2) Set the optional pattern code (0x40 to Ox7F in hexadecimal format). 
3) In [Write File Name], input the name of the file in which the optional pattern data is to be written. 
4) Click the [OK] button. The reception of the character is now started.(The code shown at [Code] now changes to 

that of the received character.) 
(*) The received optional patterns cannot be displayed in the editing area since they are in the form of the optional 

pattern language which is an intermediate language. Neither can they be edited. 
 

Characters can be received using an old VG model but they cannot be sent to one. 
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(6)Printing the optional patterns 
1) Click the [Print] button. 
2) The "Print" printer setting dialog box appears. Set the margins here. 
3) Click the [OK] button. The displayed optional pattern source code is now printed. 
4) To change the printer environment which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. Proceed with the printer settings. For details on how the items on this dialog 

box are set, refer to the instruction manual for Windows or for the printer which will be used. 
 
(7)Changing the font 

Take the following steps to change the font. When the [Font] button is clicked, the font change dialog box appears. 
The resulting settings are saved and used on the next and subsequent occasions. 
Only the font displayed in the editing area and the font for printing are affected by the settings. 
 
 
 
 



 
 

2.10.4. Convert to 256-color VBM file 
User option pattern is converted to 256-color VBM file. 
(1)Write a source code in the edit area.  Click [Compile] button, then confirm the message “Compile OK” on the 

Compile screen is displayed and compile is completed.  By doing this, option pattern language that is a “middle 
language” is made from source code.   

(2)Click［Exec］button.  Display the screen of compiled Option pattern data on the Simulation window “Execute Image”.  
If compile fails, black screen is displayed. 

(3)After confirming the pattern is displayed on the simulation screen, click [To VBM] button.  The file saving screen like 
below is displayed.  

 

⑩ 

⑨ 
⑧ 

⑦ 

⑥ 

⑤ ④ 

③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Addendum 
① Drive name of saving destination  
② Directory of saving destination Default is an image folder. 
③ VBM file list  
④ Saving VBM file name  
⑤ Old comments  
⑥ Image display / no display  
⑦ New comments  
⑧ VBM image display  
⑨ VBM file information  
⑩ VBM file saving OK/Cancel  

 
 

(4) When pressing OK button in the file saving screen, user option data becomes a file as 256-color VBM data.  It takes 
a certain amount of time to make a VBM file. 
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■ Caution when making 256-color VBM file 
 
The display color of VBM file is 256-color only.  When displaying 8-bit plane (256-color), 1-bit plane (one color) and 
Window plane (one color) simultaneously, the display color is supposed to be 258-color.  In this case, upper two-color 
of 8-bit plane is assigned to 1-bit plane and Window plane. 
 
 
(1) 8-bit, 1-bit and Window plane are displayed simultaneously. 
 

Palette No. Setting color 
0 
1 
2 
3 
. 
. 
. 

253 

8-bit plane palette 

254 1-bit plane color 
255 Window plane color 

 
(2) 8-bit and 1-bit plane are displayed simultaneously. 
 

Palette No. Setting color 
0 
1 
2 
3 
. 
. 
. 

254 

8-bit plane palette 

255 1-bit plane color 
 
(3) 8-bit and Window plane are displayed simultaneously. 
 

Palette No. Setting color 
0 
1 
2 
3 
. 
. 
. 

254 

8-bit plane palette 

255 Window plane color 
 
 
 
 



 
 

2.11. Monitoring and changing the IP/Gateway address 
 

This section describes how to monitor the statuses of the VGs which have been connected 
using a LAN communication setup. It also explains how to change the IP addresses of the 
connected VGs. 

2.11.1. Startup method 
Click the [Monitor] button of "VGBase" to start up the "Monitor." 

2.11.2. Window screen and description 
 

Monitoring 
screen IP Change

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Monitoring screen 
The statuses of the connected VGs are displayed here. 
 
IP Charge 
When this is clicked, the "IP change" dialog box appears. 
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2.11.3. Operation methods 
(1)Monitoring 

The statuses of the connected VGs can be monitored by observing the icon displays at the far left of the screen and 
checking what appear in the [State] column. 
There are three VG statuses: "Normal" (indicating that the VG is functioning normally), "VG Error." (indicating that 
trouble has occurred in the VG) and "Network Error." (indicating that trouble has occurred in the network). 
 

(2)Changing an IP address 
1) Click the [IP Change] button. 
2) The "IP change" dialog box appears. 
3) To change an IP address, check the [New IP Address] check box, and input the new IP address into the text box. 
4) When the [OK] button is pressed, the process for changing the IP address is executed. 

 



 
 

2.12. Selecting and editing the layout data files 
 

This section explains how to select and edit the layout data files used by "VGBase." 

2.12.1. Startup method 
(1)Layout Info Setting 

Click the [Select] button of "VGBase" to start up the "Layout Info Setting." 

 
Select "No Info" when no layout data files are going to be used and [Use Layout File] when they are going to be used. 
When [No Info] is selected, operation returns to "VGBase" straight away. In this case, the layout data cannot be 
edited. When [Use Layout File] is selected, the "Load File" file selection dialog box is displayed. 

 

Select the layout data file to be used, and select [OK]. (To create a new file, set the filename in the [File Name] box.)  
Operation now returns to "VGBase." 
 

(2)Layout Edit 
Click the [Edit] button of "VGBase," and start up the "Layout Edit." 
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2.12.2. Window screen and description (Layout Edit) 

■ Program tab 
 

⑤ ④ 

③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Layout Name The name of the layout data is displayed here. 
② Layout data list The program data which has been registered is displayed here. 
③ Data folder The folder of the registered program data is selected. The folder that can 

be selected by set VG is different. 
④ Data file list The data created by the editing program is displayed here. 
⑤ Set Click this to register the data from the data file list into the layout data list. 

 
 



 
 
About the data folder 
The folder of the registered program data is selected. The folder that can be selected by set VG is different. 
 

VG folder 
VG-848 Program VGInt VGInt2_848  
VG-849 Program VGInt VGInt2_849 VGInt3_849 
VG-858 Program VGInt VGInt2_848  
VG-859 Program VGInt VGInt2_849 VGInt3_849 
VG-830 Program VGInt VGInt2_848  
VG-835 Program VGInt VGInt2_835  
VG-835-A Program VGInt VGInt2_835  
VG-857 Program VGInt VGInt2_835  
Other VG Program    

 
 

■ Character 
 

④ 
③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Layout Name * See same item in program tab section. 
② Layout data list * See same item in program tab section. 
③ Data file list * See same item in program tab section. 
④ Set * See same item in program tab section. 
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■ Group tab 
 

④ 
③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Layout Name * See same item in program tab section. 
② Layout data list * See same item in program tab section. 
③ Data file list * See same item in program tab section. 
④ Set * See same item in program tab section. 

 
 
 
 
 



 
 

■ AutoDisplay tab 
 

④ 

③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Layout Name * See same item in program tab section. 
② Layout data list * See same item in program tab section. 
③ Data file list * See same item in program tab section. 
④ Set * See same item in program tab section. 
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■ Image tab 
 

④ 

③ 
② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Layout Name * See same item in program tab section. 
② Layout data list * See same item in program tab section. 
③ Data file list * See same item in program tab section. 
④ Set * See same item in program tab section. 

 
 
 
 
 
 
 
 



 
 

■ Opt-Ptn tab 
 

④ 
③ 

② 

① 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Layout Name * See same item in program tab section. 
② Layout data list * See same item in program tab section. 
③ Data file list * See same item in program tab section. 
④ Set * See same item in program tab section. 
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2.12.3. Operation methods (Layout Edit) 

■ Editing the layout data 
1) Click the tab ([AutoDisplay], [Image], [Opt-Ptn], [Program], [Character] or [Group]) corresponding to the type of data 

which is to be registered as the layout data. The [Selectable File List] of the data file which corresponds to the 
selected tab is displayed. 

2) Select the data to be registered from the [Selectable File List]. 
3) Place the cursor at the cell of the position where the data is to be registered in the layout data list. 
4) When the [←] button is clicked, the data is registered from the [Selectable File List] into the layout data list. Repeat 

these steps to create the layout data. Use the respective editing programs to create the data files on the data file list. 
 

■ Saving the layout data 
The displayed layout data is saved in the file. 
Click the [Save] button. ⇒The data is saved in the selected file and any existing data in that file is overwritten. 
Click the [Save As] button. ⇒ The data is saved in a new file. 
(*) When the data is to be used temporarily: 
When the edited layout data is to be tested or when the layout data is to be used temporarily in the editing programs 
started up from "VGBase," simply select the Close button and close the editing screen. If an attempt is made to close 
"VGBase" without saving the data, a message which warns the operator of the loss of the post-edited layout data will 
appear. At this time, save the data again. 
 

■ Sending the data 
1) Click the [Send] button. The "Transfer Data" data selection dialog box appears. 
2) Select the data to be sent. Before sending it, check the data. (It takes time for all the data to be sent. To test sending 

the data quickly, check [Character Data] or [Auto Display Data], and send it.) 
3) Click the [OK] button. 
4) The selected data is sent to the VG. 
(*) The data is sent on the basis of the layout data information. Data numbers and code data which have not been set in 

the layout data will not be sent. This means that the sent data will be registered and updated by the VG, but the 
statuses of the data numbers and code data which are not sent will remain unchanged from the pre-transmission 
statuses. 

 



 
 

■ Receiving the data 
1) Click the [Receive] button. The "Transfer Data" data selection dialog box appears. 
2) Select the data to be received. Before receiving it, check the data. (It takes time for all the data to be received. To test 

receiving the data quickly, check [Character Data] or [Auto Display Data], and receive it.) 
3) Click the [OK] button. 
4) The progress display starts, and the selected data is received from the VG. 
5) The layout data list is updated in accordance with the data which has been received. 
(*) Bear in mind that since the layout data will be overwritten in accordance with the data which has been received, 

some of the layout data being edited will be rewritten. 
(*) Before receiving the data, check whether or not the data has been registered in the VG, and receive only data which 

has been registered. The layout data is updated only on the basis of the numbers of the data registered in the VG. 
Layout data with the numbers of the data not registered in the VG will not be updated, and their pre-reception 
contents will remain unchanged. Therefore, to create new layout data by data reception, the first step to be taken is to 
specify a new file by performing the steps for selecting a layout data file or clear the layout data being edited. 

(*) Precaution when groups are to be received separately 
Groups are managed in the VG by program data numbers, and these numbers are received also when the data is 
received from the VG. If layout data has been used, steps are taken to ensure that the program data numbers 
correspond to the program files on the basis of the layout data information. A correct correspondence will be 
established if the layout data of a program matches what has been registered in a program inside the VG. If they do 
not match, the program name and program file will not be found, and data will not be saved in the file. This means that 
the program data number and program name will not be displayed even when the group contents are checked using 
the group editing program. To ensure that this problem does not occur, before receiving groups, either receive a 
program or select the layout data setting which does not call for the layout data to be used. 

 
 

86



Chapter 2 Operation
 

 
 

87

2.13. Setting the port number and IP address 
 

This section describes how to set the port number and IP address for the individual VGs 
which are connected serially. 

2.13.1. Startup method 
Select [Start] → [Programs] → [SP-8848] → [IPAddressSet]. 

2.13.2. Window screen and description 
 

④ 

③ 
② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Port No. The number of the VG's port is set here. 
② Serial settings ● Com port: The port number is selected here. 

● Speed: The transfer (baud) rate is set here. 
● Data Size: The communication data size is set here. 
● Parity: "Even," "Odd" or "None" is selected as the parity here. 
● Stop Bits: "1," "1.5" or "2" is selected as the stop bits. 

③ IP address The IP address of the VG is set here. 
④ Send Set Internet Protocol address is transmitted to VG. 

 
 
 
 
 
 



 
 

2.13.3. Operation methods 

■ Setting the port number and IP addresses 
1) Select the serial settings in each of the text boxes under [Serial Setting]. 
2) Input the port number which is to be set in the [Port No] text box. Set the same port number for all the VGs connected 

by LAN communication. 
3) Input the IP address to be set in the [IP Address] text box. Set a different IP address for each VG. 
4) Press the [Send] button. The port number and IP addresses are sent to the VGs. 
 

2.13.4. General IP address classes 
IP addresses fall into two categories, ones (global addresses) which are allocated to computers connected to the 
Internet and ones (private addresses) which are used by LANs, etc. 
 

Depending on the IP address, the following conventions apply to the private addresses used for LANs. 
 
Class A 
10.0.0.0 to 10.255.255.255 
The number used for the 3-digit number in the first block is always "10," and it is followed by combinations of numbers 
from 0 to 255. Use of this class of IP address enables up to 16 million computers to be connected by a single network. 
 
Class B 
172.16.0.0 to 172.31.255.255 
The number used for the 3-digit number in the first block is always "172," and numbers from 16 to 31 are used for the 
3-digit number in the second block. Use of this class of IP address enables up to 65,534 computers to be connected by 
a single network. 
 
Class C 
192.168.0.0 to 192.168.255.255 
The numbers used for the 3-digit number in the first two blocks are always "192.168," and numbers from 0 to 255 are 
used for the 3-digit number in the third block. Numbers "0," "1" and "255" are not normally allocated as the 3-digit 
number in the fourth block. 
Use of this class of IP address enables up to 256 computers to be connected by a single network. 
 
The IP addresses in class C are used to configure a LAN in an environment such as a small-scale office. 
*IP address Class D also exists, but since the addresses in this class are special IP addresses used for multi-cast 
communication, they should not be used. 
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2.14. Color difference coefficient data editing program 
 

This section describes how to use the editing program to set the color difference coefficient 
data of the VG. The program enables the color difference coefficient data of the VG to be 
edited in Windows, the edited color difference coefficient data to be sent to the VG, and 
color difference coefficient data from the VG to be received. 

2.14.1. Startup method 
Select [Start] → [Programs] → [SP-8848] → [CDCEdit]. 

2.14.2. Window screen and description 
 

④ 

③ ② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Details 
① Toolbar ● Load: Click this to load the color difference coefficient data. 

● Save: Click this to save the color difference coefficient data in a file 
and overwrite any existing data in that file in the process. 

● Save As: Click this to save the color difference coefficient data in a 
new file. 

● Send: Click this to send the color difference coefficient data which is 
being edited to the VG. 

● Receive: Click this to receive the color difference coefficient data from 
the VG. 

● Print: Click this to print the color difference coefficient data. 
② Teble No The number of the color difference coefficient data table which has been 

sent to or received from the VG appears here. 
③ Name The name of the displayed color difference coefficient data appears here. 
④ Editing area This is the part of the screen where the color difference coefficient data is 

created, changed and displayed. 
 



 
 

2.14.3. Operation methods 
(1)Loading the file 

The color difference coefficient data is loaded from a file in which it was saved. 
1) Click [Open] on the [File] menu. The file selection dialog box now appears. 
2) Select the file, and press the [OK] button.  
3) The data of the selected file is now displayed. 
 

(2)Creating and editing the color difference coefficient data 
The color difference coefficient data is edited. 
1) Input the data in a range from 0.0000 to 1.0000. 
2) Input the name of the data in "Name." This name can consist of a maximum of 20 characters. 
 

(3)Saving the file 
The displayed data is saved in a file. 
When [Save] on the [File] menu is selected, the data is saved in the selected file and any existing data in that file is 
overwritten. 
When [Save As] on the [File] menu is selected: 
1) The file selection dialog box appears. 
2) Input the filename, and press the [OK] button. The displayed data is now saved in the new file. 
 

(4)Sending the color difference coefficient data  
The color difference coefficient data is saved in the VG. 
1) Click [Send] on the [VG] menu. The send dialog box appears. 
2) Set the number of the data table. 
3) Select the [OK] button. The color difference coefficient data is now sent to the VG. (The table number of the data 

sent now replaces the previous number appearing in [Table No.].) 
 

(5)Receiving the color difference coefficient data  
The color difference coefficient data from the VG is loaded. 
1) Click [Receive] on the [VG] menu. The receive dialog box appears. 
2) Set the number of the data table. 
3) Select the [OK] button. The reception of the color difference coefficient data now starts. (The table number of the 

data received now replaces the previous number appearing in [Table No.].) 
 

(6)Printing the color difference coefficient data  
The displayed color difference coefficient data is printed. 
1) Click [Print] on the [File] menu. 
2) The print dialog box appears. Set the block numbers to be printed and the margins here. 
3) Press the [OK] button. The displayed color difference coefficient data is now printed. 
4) To change the printer which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. 
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2.14.4. Menus 

■ [File] menu 
Load This is used to load data from the files. 
Save This is used to save data in the files. 
Save As  This is used to save the data under a different filename. 
Print This is used to print the displayed data. 
Close This is used to close the program. 

 

■ [VG] menu 
Send to VG This is used to send the color difference coefficient data being edited to the 

VG. 
Receive from VG This is used to receive the color difference coefficient data from the VG. 

 

■ [Help] menu 
Contents This displays the help information. 
Index This displays a list of the help topics which can be searched. 
About This displays the version information. 

 

 



 
 

2.15. Creating and editing the DDC data 
 

This section describes the program used to set DDC data of the programmable video signal 
generator (hereafter abbreviated to "VG"). The program enables the DDC data of a 
DDC-compatible monitor to be send, received and edited in Windows. 

2.15.1. Startup method 
Select [Start] → [Programs] → [SP-8848] → [DDCEdit]. 

2.15.2. Window screen and description 
 

⑥ ⑤ 

④ 

③ 

② 

① 
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No. Item Details 
① DispMode selectors These are used to select either the GUI display mode or the binary display 

mode. 
● GUI display mode 

For the block types supported by this mode, the data is displayed on a 
screen that allows for easy graphical readout. For block types which are 
not supported, the data is displayed in the binary mode. 

● Binary display mode 
The data is displayed in a 128-byte binary format. 

② Toolbar ● Open: Click this to open the DDC data. 
● Save: Click this to save the DDC data in a file and overwrite any existing 

data in that file in the process. 
● Save As: Click this to save the DDC data in a new file. 
● Send: Click this to send the DDC data which is being edited to the 

monitor. 
● Receive: Click this to receive the DDC data from the monitor. 
● Verify: Click this to compare the DDC data being edited against the data 

stored in the monitor's ROM. 
● Print: Click this to print the DDC data. 
● Comment: A comment for the DDC data can be entered here. 

③ Block type list A list of the block types appears here. The block number and block type 
(1-byte block code at the head) are displayed for each block. 

④ Data display The data of the block selected on the block type list on the left is displayed 
here. 

⑤ Checksum The checksum value is displayed here. 
The checksum is the value of the last byte of the block. 
When "Auto checksum" is checked, the checksum value is automatically 
updated each time the data is changed. 

⑥ Automatic checksum 
calculation ("Auto 
checksum") 

When this is checked, the checksum value is automatically updated each time 
the data is changed. 

 
 



 
 

2.15.3. peration methods 

■ Creating new DDC data 
1) Click [New] on the [File] menu. 

The dialog box for selecting the number of blocks (size of the monitor ROM) to be created appears. 
2) Select a number of blocks which are to be created to fit in with the size of the monitor ROM, and press the [OK] 

button. The specified number of blocks are now created. The initial value of all the data is "0." 
(*) The number of blocks can be changed even after new blocks have been created. 
 

■ Opening the file 
A file which has been saved is opened, and the DDC data is loaded from it. 

1) Select [Open] on the [File] menu or select the  button from among the tool buttons. 
2) Select the file, and press the [OK] button.  
3) The selected file is opened, and the DDC data in that file is displayed. 
 

■ Loading the data in individual blocks from the file 
The DDC data in the specified block is loaded from the file. 
1) Select the block whose DDC data is to be loaded. 
2) Click [Load One-Block] on the [File] menu. The file selection dialog box appears. 
3) Select the file, and press the [OK] button. Next, the block selection dialog box appears. 
4) Select the block whose data is to be loaded, and press the [OK] button. 
5) The DDC data in the specified block is loaded and displayed. 
 

■ Editing the DDC data 
The block type is determined first, and then the data is edited. 
1) Decide which block type is to be selected. Select the block to be edited, and click [Change Block Type] on the [Edit] 

menu. The block type selection dialog box appears. Select the target block type, and press the [OK] button. 
2) If the GUI display mode is established at the time, the display format is switched by the block type. If the binary 

display mode is established at the time, 128 bytes are dumped and displayed. For details on the data, refer to the 
reference documentation. 

 

■ Saving the file 
The displayed data is saved in a file. 

1) When [Save] on the [File] menu is selected or the  button among the tool buttons is clicked, the data is saved in 
the selected file and any existing data in that file is overwritten. 

2) When [Save As] on the [File] menu is selected or the  button among the tool buttons is clicked, the file selection 
dialog box appears. Input the filename and press the [OK] button. The displayed characters are saved in the new file. 
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■ Sending data to the monitor 
The DDC data is saved in the monitor ROM. 

1) When [Send] on the [VG] menu is selected or the  button is clicked on the toolbar, the send dialog box appears. 
2) Select DDC1 or DDC2B, and decide on the numbers of the blocks (how many blocks starting from block #0) to be 

sent. When the [Fix Monitor] button is pressed, communication with the monitor is initiated, and the amount of the 
data can be matched with the maximum size of the monitor ROM. 

3) Press the [OK] button. The DDC data is now sent. 
 

■ Receiving data from the monitor 
The DDC data is loaded from the monitor ROM. 

1) When [Receive] on the [VG] menu is selected or the  button is clicked on the toolbar, the receive dialog box 
appears. 

2) Select DDC1 or DDC2B, and decide on the numbers of the blocks (how many blocks starting from block #0) to be 
received. Press the [OK] button to start receiving the DDC data. 

3) The received DDC data is now displayed. 
 

■ Verifying the data against the data in the monitor ROM 
The DDC data is loaded from the monitor ROM, and the DDC data now being edited is checked against it. 

1) When [Verify] on the [VG] menu is selected or the  button among the tool buttons is clicked, the verify dialog 
box appears. 

2) Select DDC1 or DDC2B, and decide on the numbers of the blocks (on how many blocks starting from block #0) are to 
be sent and on the mask settings. The mask settings can be set only for the product code and serial number of the 
Basic EDID. If these items are checked, they will not be verified. 
When the [Fix Monitor] button is pressed, communication with the monitor is initiated, and the amount of the data can 
be matched with the maximum size of the monitor ROM. Press the [OK] button to start verifying the DDC data. 
 

■ Printing the DDC data 
The displayed DDC data is printed in the binary format. 

1) Select [Print] on the [File] menu or select the  button among the tool buttons. 
2) The print dialog box appears. Set the block numbers to be printed and the margins here. 
3) Press the [OK] button. The displayed DDC data is now printed in the binary format. 
4) To change the printer which has been set, click the [Set Printer...] button. 
5) The printer setting dialog box appears. 
 



 
 

2.15.4. Menus 

■ [File] menu 
Menu command Description of function 
New This is used to create new data. 
Open This is used to open a file. 
Load One-Block This is used to load the data of one block from a file. 
Save This is used to save data in the files. 
Save As This is used to save the data under a different filename. 
Close This is used to close the file. 
Properties This is used to display the file properties. 
Print This is used to print the displayed data. 
Exit DDC Editor This is used to exit the program. 

 

■ [Edit] menu 
Menu command Description of function 
Insert-up Block This is used to insert a new block before the current block. 
Insert-down Block This is used to insert a new block after the current block. 
Delete Block This is used to delete a block. 
Copy Block This is used to copy a block. 
Move Block This is used to move a block 
Change Block Type This is used to change the block type. 

 

■ [VG] menu 
Menu command Description of function 
Send to VG This is used to send the DDC data being edited to the monitor. 
Receive from VG This is used to receive the DDC data from the monitor. 

Verify 
This is used to check the DDC data being edited against the data in the 
monitor ROM. 

 

■ [Option] menu 
Menu command Description of function 

Binary Byte（1 byte） 
With a binary format display, this is used to delimit the data on a byte 
by byte basis, and display the data. 

binary Short（2 byte） 
With a binary format display, this is used to delimit the data every 2 
bytes, and display the data. 

Binary Long（4 byte） 
With a binary format display, this is used to delimit the data every 4 
bytes, and display the data. 

DDC2B This is used to communicate using DDC2B. 
DDC1 This is used to communicate using DDC1. 

 

 
 

96



Chapter 2 Operation
 

 
 

97

■ [Help] menu 
Menu command Description of function 
Contents This displays the help information. 
Index This displays a list of the help topics which can be searched. 
About This displays the version information. 

 

2.15.5. Block operations 

■ Inserting a block before the current block 
Click the block immediately below the position where the block is to be inserted. 
Click [Insert-up Block] on the [Edit] menu. 

■ Inserting a block after the current block 
Click the block immediately above the position where the block is to be inserted. 
Click [Insert-down Block] on the [Edit] menu. 

■ Deleting a block 
Click the block to be deleted. 
Click [Delete Block] on the [Edit] menu. 

■ Copying a block 
Click the block to be copied. 
Click [Copy Block] on the [Edit] menu. 

■ Moving a block 
Click the block to be moved. 
Click [Move Block] on the [Edit] menu. 

■ Changing the block type 
Click the block whose type is to be changed. 
Click [Change Block Type] on the [Edit] menu. 
 



 
 

2.16. Cursor tool program 
 

This section describes how to move the VG's cursor pattern just as would be done using a 
mouse and save the coordinates of defective pixels and other data in files. 

2.16.1. Startup method 
Select [Start] → [Programs] → [SP-8848] → [Curtool]. 

2.16.2. Window screen and description 
 

⑨ ⑧ ⑦ ⑥ 

⑤ 

④ 

③ 

② 

① 
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No. Item Details 
① Toolbar ● New: Click this to create a new defective pixel list. 

● Save: Click this to save the defective pixel list in a file and overwrite any 
existing data in that file in the process. 

● Save As: Click this to save the defective pixel list in a new file. 
● Pixel: Click this to add missing pixels to the defective pixel list. 
● Line: Click this to add missing lines to the defective pixel list. 
● Uniformity: Click this to add lost uniformity to the defective pixel list. 
● etc: Click this to add other missing or lost aspects (other than pixels, lines 

and uniformity) to the defective pixel list. 
● Reset: Click this to retry communication with the VG. 
● Print: Click this to print the defective pixel list. 

② Output screen image 
display 

Images of the VG's output screens appear here. The cursor pattern can be 
moved by dragging the image with the mouse or pressing the arrow buttons. 

③ Comment A comment can be entered for the whole defect list here. 
④ Position (cursor pattern 

position) 
The current cursor pattern coordinates are displayed here. When these 
coordinates are changed, the cursor pattern is moved. 

⑤ Cursor pattern properties The cursor pattern properties are displayed and changed here. 
When they are changed, the VG's settings are changed, but the "Flicker" and 
"PosDisp" settings are not reflected on the screen image displays provided by 
this program. 

⑥ Defective pixel list Defective pixels are continuously being added to this list. 
⑦ Scale ratio The scale ratio of the output screen image display is displayed here as a 

percentage. It is automatically calculated from the timing data being executed 
and screen size. 

⑧ Resolution The resolution of the timing data being executed is displayed here. 
⑨ Status The kind of status data which appears here changes in accordance with the 

mouse position. When the mouse is on the output screen image display, the 
mouse coordinates are indicated; at other times, suggestions or comments 
appear. 

 
 
 



 
 

2.16.3. Operation method 

■ Startup 
At startup, the VG model and currently executed resolution are captured, and a screen matching these states is 
displayed. In addition, the cursor pattern position changes to the center coordinates and the properties change to the 
default values. 
1) Connect the VG and monitor, and display the VG's output screen on the monitor. 
2) Connect the PC and VG, and turn on the power of the VG. 
3) Set the VG to a state in which the cursor pattern is selected after some kind of timing data has been executed. The 

cursor pattern is now displayed on the monitor. 
4) Start this program from the start menu. 
* In the following cases, an error message appears, and no further communication is possible. To resume 
communication, either restart the program or press the Reset button on the toolbar after the program has started to 
retry communication. 

 
¾ When the VG has not been connected 
¾ When no timing data at all has been executed after the power of the VG was turned on 
¾ When the cursor pattern has not been selected. 

* Retrying communication  
Retry communication with the VG. 
Just as at the startup stage, the VG model and currently executed resolution are captured, and a screen matching 
these states is displayed. In addition, the cursor pattern position changes to the center coordinates and the properties 
change to the default values. 

■ Moving the cursor pattern 
The coordinates can be changed by dragging the mouse, clicking the arrow buttons or inputting the data directly into 
the coordinate boxes. 

Method Operation 
Dragging the 
mouse 

This moves the pattern to the coordinates to which the 
mouse was dragged. 

Clicking the arrow 
buttons 

This moves the pattern by one pixel each time one of 
the buttons is pressed. 

Inputting data 
directly into the 
coordinate boxes 

This moves the pattern to the position of the coordinates 
which have been input. 
 

 

■ Adding to the defective pixel list  
Types, coordinates, cursor colors, background colors, dates/times and comments can be added as the defective pixel 
data to the defective pixel list. 
1) Align the cursor pattern with the defective pixel. 
2) In accordance with the defect type, press the button used to add the defective pixel. 
3) Select [Input Remarks] on the [Data] menu, and input a comment. 
* To delete a line from the defective pixel list, select the line to be deleted, and select [Delete] on the [Data] menu. 
To delete all the lines, select [All Delete] on the [Data] menu. 
* To create a new defective pixel list, select [New] on the [File] menu. 
● Click [New] on the [File] menu. 
● The defective pixel list, comments and filenames are all cleared. 
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■ Saving a defective pixel list in a file 
¾ The displayed defective pixel list is saved in a file. 
¾ The list is saved in the comma-delimited CSV format (with the .CSV extension). 
¾ When [Save] on the [File] menu is selected: 
¾ The data is saved in the selected file and any existing data in that file is overwritten. 
¾ When [Save As] on the [File] menu is selected: 

1) The file selection dialog box appears. 
2) Input the filename, and press the [OK] button. The displayed defective pixel list is now saved in the new file. 

■ Printing the defective pixel list  
The displayed defective pixel list is printed. 
1) Click [Print] on the [File] menu. 
2) The print dialog box appears. Set the block numbers to be printed and the margins here. 
3) Press the [OK] button. The displayed defective pixel list is now printed. 
4) To change the printer which has been set, select the [Set Printer...] button. 
5) The printer setting dialog box appears. 

■ Closing the program 
The program is closed by selecting [Close] on the [File] menu. 

2.16.4. Menus 

■ [File] menu 
New This is used to create a new defective pixel list. 
Save This is used to save the defective pixel list in a file. 
Save This is used to save the defective pixel list under a different filename. 
Print This is used to print the defective pixel list. 
Close This is used to close the program. 

 

■ [Data] menu 
Pixel This is used to add dot defects to the defective pixel list. 
Line This is used to add line defects to the defective pixel list. 
Uniformity This is used to add lost uniformity to the defective pixel list. 
etc. This is used to add other defects to the defective pixel list. 
Delete This is used to delete the selected line of the defective pixel list. 
All Delete This is used to delete all the lines of the defective pixel list. 
Input Remarks This is used to input a comment on the selected line of the 

defective pixel list. 
 

■ [VG] menu 
Reset This is used to retry communication. 

 

■ [Help] menu 
Contents This displays the help information. 
Index This displays a list of the help topics which can be searched. 
About This displays the version information. 



 
 

2.17. All data copy tool  
 

 
 

All data of VG can be copied to the same model VG that are connected through LAN communication at once.

2.17.1. Startup method 
Select the [Distributor] in [SP-8848] in [Program] of [start] 

2.17.2. WINDOW SCREENS AND DESCRIPTION 
 

⑥ 

⑤ 

④ ③ 

② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Item Details 
① Data selection Select transmitting data 
② Data reception This function is to receive the data from VG that has original data.  Press the 

“Receive” button and IP address(VG) which has been already set is displayed.  
Select the VG that has original data and the data is received.  During the data 
reception, the dialog that shows progress bar, total numbers of copied file etc 
are displayed. 

③ Data send This function is to send the data to the connected VG.  The transmission starts 
by pressing the “Send” button.  During the data transmission, the dialog that 
shows progress bar, total numbers of copied file etc are displayed. 

④ Status display Display the VG type that has original data. 
⑤ Show error The error is displayed. 
⑥ Exit Close the distributor screen. 
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2.17.3. OPERATION 
 

(1) Before startup 
1) Set LAN communication and IP address (VG) in the screen of [Config] in [VG Base]. 
2) Use the same VG model, and the same IP address. 
3) If the copied VG and copy to VG is not the same model, the data cannot be transferred. 
4) The IP address which is set in No.1 in [Config] of [Base] are reflected. 
 

(2) Startup 
1) Connect LAN communication of copied VG and copy to VG. 
2) Connect PC to the copied VG and turn on each VG power. 
3) Start this program from the [start menu]. 
* Do not turn off the power of VG during data transmission, otherwise the data may be broken. 
 

(3) Select the transmission data 
1) Select the check box of transmitting data. 
2) Only checked data is transmitted. 

 
(4) Data reception 

Data is received from arbitrary VG. 
1) Press the “Receive” button. 
2) Selection screen of IP address(VG) is displayed.  The IP address that has been set in [Config] of [VGBase] is 

displayed. 
3) Press “OK” button and data reception starts. 
4) The screen shows the data is receiving. 
5) When completing the data reception, the reception screen ends. 
 

(5) Data transmission 
Data is transmitted to the same VG model that is connected through LAN communication. 
1) Select the sending data.  If selecting un-received data, the data is not transmitted. 
2) Press the “Send” button, and the screen shows the data is sending. 
3) When completing the data transmission, the transmission screen ends.  

 
* The first set IP setting is reflected for data transmission.  If the first IP setting of VG is set as Class C, the data is 
transmitted only to the VGs whose class is set as C. 

 



 
 
e.g.) Suppose the data is set as below in [VGBase]Æ[Config]Æ[Interface]Æ [VG(LAN)]. 
 
  

No. VGName IP address Setting of IP address 
1 VG1 192.168.16.54 Class C 
2 VG2 192.168.16.55 Class C 
3 VG3 192.255.255.255 Class A 
4 VG4 172.16.255.255 Class B 
5 VG5 192.168.16.60 Class C 

 
In this case, the IP address that is set in No. 1 is Class C, the data is transmitted only to VG1, VG2 and VG5 whose IP 
address is set as Class C.  The data is not transmitted to VG3 and VG4, since they are set as different class. 
 
 
(6) Error status 

The VG that occurs transmission error and error contents are displayed. 
 
(7) Program ends 

Press [Exit] button and the program closes. 
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2.18. ClosedCaption/V-chip data transmission tool 
 
 
 
 

 
* This tool can be used with VG-848,858,849,859,849C,859C. 
 

2.18.1.Startup method 
Select [Start] - [Programs] - [SP-8848] - [CCVEdit]. 

2.18.2. Window screen displays and descriptions  

■ Caption data setting screen  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Described here are the steps taken to send the closed caption data and V-chip data to the VG generator or 
receive the data from the VG generator and also to save the data settings in files. 

① 

② 

③ 

④ 

⑤ ⑥ 

⑦ 

⑧ 

⑨ 
⑩ 

⑪ 

⑫ 

⑬ 

⑭ 



 
 
Caption setting screen  

No. Item Details 
① V-chip setting display This button is used to display the V-chip setting screen. 
② CC mode settings These are used to select closed caption mode 1, 2, 3 or 4 or select text mode 1, 

2, 3 or 4.  When a text mode has been selected, the text setting screen is 
displayed. 

③ CC style settings These are used to set the caption data style.  Depending on the style setting, 
the number of caption data which can be set varies. 
● Roll-up2, 3 or 4: 2, 3 or 4 rows can be edited.  The rows selected must be 

consecutive. 
● Pop-on, Paint-on: Up to four rows can be edited.  Any rows can be 

selected. 
④ Tool buttons ● Load: Press this to load the data from a file. 

● Save: Press this to save the edited data in a file. 
● Send: Press this to send the edited data to the VG generator, and register it 

in the generator. 
● Receive: Press this to receive data from the VG generator. 
● Execute: Select UserNo. from the registered ClosedCaption data and 

execute it. 
⑤ CaptionStyle setting This is used to display the font data and background Style setting screen. 
⑥ UserNo The pattern number of the sent or received caption data appears here. 
⑦ ROW When a row box is checked, data can be set on that row.  The selection method 

differs depending on the style set. 
⑧ Caption setting screen Input the Caption data.  The text data should be ASCII letters of 20h to 7Fh. 

Control data cannot be inputted.  Use binary editor when inputting the control 
data. *1 

⑨ Binary editor display Check it and the buttons can be selected.  Press the button and the binary 
editor starts.  The setting Caption data is binary-displayed.  On the contrary, 
the value that is edited by the binary editor can be set in the editor.  If Binary is 
checked, caption data input editor cannot be used. 

⑩ Position The positions at which the text data is to be input are set here. 
⑪ Text color settings The text colors are set here.  White, red, green, blue, cyan, yellow or magenta 

can be selected. 
⑫ BG color settings The background colors are set here.  White, black, red, green, blue, cyan, 

yellow or magenta can be selected. 
⑬ Help This is pressed to display the help information. 
⑭ Close This is pressed to close the program. 

 
*1 After editing the control code by Binary editor, if character code is re-edited by Caption editor, 
the control code that exists in the re-edited Caption data is all delted. 
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■ FontStyle setting screen  
 
 
 
 
 
 
 
 
 

⑦ 

⑥ 

⑤ 

④ 

③ 

② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
FontStyle setting screen  

No. Item Details 
This is pressed to set the FontStyle data which has been checked. ① SET 

These are the numbers of the rows in which the settings are to be reflected. ② No 

Makes the checked Caption oreground.  * Invisible on the application. ③ Foreground 

When one of these boxes is checked, the background becomes opaque.  This 
cannot be verified due using the application. 

④ Opaque 

⑤ Underline When one of these boxes is checked, Font is underlined. 
⑥ Italic When one of these boxes is checked, the font is italicized. 
⑦ Flash When one of these boxes is checked, the flashing is set to ON.  This cannot 

be verified using the application. 
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■ Binary editor 
 
 
 
 
 
 
 
 
 
 
 
 
 
Binary data setting screen 

No. Item Details 
① SET button This is pressed to convert the edited binary data into the caption data. 
② Length The number set here becomes the effective character numbers.  For example, if 32 

letters data is input, but the “5” is input in the “length” item, the effective character 
data is from 1 to 5. 

③ Control data The control data is set in the pull-down menu. If the setting data is from 11h, 12h, 
13h, 19h,1Ah, and 1Bh,the control data is applied to the first byte of two bytes letters.  
If control data is present, one character data will consist of 2 bytes (= 1 byte for the 
control data and 1 byte for the character data value in the edit box on the right.)  
The control data which can be setting by the caption style set up differs. 
CC1 and CC3 : 11h, 12h, 13h 
CC2 and CC4 : 19h, 1Ah, 1Bh 

④ Character data Character code is set in an edit box part.  If one byte letter does not have control 
data, one edit box consists one character.  The control data of one byte letter 
appears as “--". 

 
 

① 
② 

④ 

③ 
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■ Text data setting screen 

⑨ 

⑧ 

⑦ 

⑥ 

⑤ 

④ 

③ 

② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
Text setting screen 

No. Item Details 
① V-chip setting display This button is used to display the V-chip setting screen. 
② CC mode settings These are used to select closed caption mode 1, 2, 3 or 4 or text mode 1, 2, 3 or 

4.  When a text mode has been selected, the text setting screen is displayed. 
③ Tool buttons Load: Press this to load the data from a file. 

Save: Press this to save the edited data in a file. 
Send: Press this to send the edited data to the VG generator, and register it in the 
generator. 
Receive: Press this to receive data from the VG generator. 
Execute: Select UserNo. from the registered ClosedCaption data and execute it. 

④ UserNo The pattern number of the sent or received text data appears here. 
⑤ ArticleName The article name appears here. 
⑥ Text Input the Text data.  The text data should be ASCII letters of 20h to 7Fh. 

Control data cannot be inputted.  Use binary editor when inputting the control 
data. *1 

⑦ Binary settings Check it and the buttons can be selected.  Press the button and the binary editor 
starts.  The setting Caption data is binary-displayed.  On the contrary, the value 
that is edited by the binary editor can be set in the editor.  If Binary is checked, 
caption data input editor cannot be used. 

⑧ Help This is pressed to display the help information. 
⑨ Close This is pressed to close the program. 

 
*1 If a Text editor performs the reorganization collection of a character code after editing a control code by the 
binary editor, all the control codes that exist in the Caption data which carried out the reorganization collection 
will be deleted. 
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■ V-chip setting screen  
 

⑫ ⑪ 

⑩ 

⑨ 

⑧ 

⑦ 

⑥ 

⑤ ④ 

③ 

② 

① 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
V-chip Setting screen 

No. Item Details 
① CC setting display This is pressed to display the closed caption setting screen. 
② Tool buttons ● Load: Press this to load the data from a file. 

● Save: Press this to save the edited data in a file. 
● Send: Press this to send the edited data to the VG generator, and register it in 

the generator. 
● Receive: Press this to receive data from the VG generator. 

③ Program No The number of the program which has been sent or received appears here. 
④ System This is where the system setting is selected.  OFF,MPAA, U.S. TV, Canadian 

English or Canadian French can be set. 
⑤ Rating This is where the rating classifications are set.  The items which can be set differ 

depending on the system. 
● MAPP: G., PG, PG-13, R, NC-17, X 
● U.S.TV: TV-Y, TV-Y7, TV-G, TV-PG, TV-14, TV-MA 
● English: E, C, C8+, G, PG, 14+, 18+ 
● French: E, G, 8ans+, 13ans+, 16ans+, 18ans+ 
 
This is where the U.S. TV extension system is selected.  None, FV, V, S, L or D can 
be set. 

⑥ Interval This is where the interval at which the rating data is to be sent is set.  Any interval 
from 0 to 1023（v）  can be set 

⑦ UserNo The closed caption pattern number is set here. 
⑧ LoopTime Displays the caption data that was looped by every setting value. Any LoopTime 

from 0 to 10 seconds can be set. 
⑨ Delay Starts the display of  the Caption data after the fixed time. Any Delay from 0 to 10 

seconds can be set 
⑩ DefaultData Select the Mode and Style settings for the default caption data output. 
⑪ Help This is pressed to display the help information. 
⑫ Close This is pressed to close the program. 

*  For further details on the settings, refer to the instruction manual of the VG generator (VG-858). 
 
 
 
 
 
 
 

 
 

112



Chapter 2 Operation
 

 
 

113

2.18.3. Operation method 

■ ClosedCaption 
(a) Closed captions 

Start up the program.  The closed caption setting screen is the first screen to appear after startup. 
(b) Select the closed caption mode style.  The number of rows of data which can be edited differs depending on the 

selected style. 
(c) Enter a check mark in the ROW check box corresponding to the row to be edited.  Data can now be written into the 

editor area which has been checked. 
(d) Write the data in the editor area.  Up to 32 characters can be written on each row. 
(e) Set the text and background colors.  To change the text style, press the DataEdit button to open the 

FontStyleEditor screen, enter check marks in the boxes of the setting items, and press the SET button. 
(f) In cases where characters containing control data are to be set, for instance, use the binary editor to perform the 

settings. 
(g) When the binary editor is to be used for editing, press the B button alongside the row in which the data is to be 

written, and open the binary editor. 
(h) If the row to be edited already contains some data when the binary editor is opened, the data on the row will be 

displayed on the binary editor screen. 
(i) Upon completion of the editing using the binary editor, press the SET button.  The binary data is converted into 

ASCII characters and displayed.  However, "." appears for each control data. 
(j) Press the Send button, select the VG generator serving as the sending destination and UserNo, and send the data. 
 

■ Text 
(a) When one of the text settings is selected using the CC mode setting radio buttons, the corresponding text mode 

screen is displayed. 
(b) Input the article name and text data in the editor area. 
(c) When a check mark is placed in the Binary check box alongside the text data input field, the data is processed as 

binary data by the VG generator to which the data was sent.  
(d) Press the Send button, select the VG generator serving as the sending destination and UserNo, and send the data. 
 

■ EDS（V-chip） 
(a) Press the V-chip & CCNo button.  The V-chip setting screen now appears. 
(b) Select the System setting. 
(c) Select the Rating settings.  Bear in mind that the rating items which can be set differ depending on the System 

setting selected.  Operation is not executed if wrong Rating items have been set. 
(d) When "U.S. TV" has been selected as the System setting, a setting can be selected for Extension (extension 

system).  If nothing is to be selected here, set "None." 
(e) Select the Interval setting in 0.1 second increments.   
(f) Select the execution time in 1 second increments. 
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33  10bit Image data 
 

3.1. 10bit Image data 
10bit image data of the yacht barber who shows in the figure below is appended to SP-8848.  
The resolution becomes 1920x1080. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Caution 

 

A copyright of yacht harbor of an upper figure belongs to "corporate judicial

person Institute of Image Information and Television Engineers". 
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44  Error message reference 
 

Error message Code 
(HEX) 

Description of error 

Panel ROM Unsetted 00 The EE-PROM has not been inserted into the panel ROM socket or the 
memory card has not been installed. 

Prog No Disabled 01 The number of the program which was input turns out to have been set 
to "Disable" when direct display or a program is executed. 

DotClk over 02 DotClock in the horizontal timing data is outside the specified range. 
Hfp over 03 The front porch in the horizontal timing data is outside the specified 

range. (Hperiod ?>=? Hsync + Hbackp + Hdisp) 
HD over 05 HDstart + HDwidth in the horizontal timing data is outside the specified 

range. (Hperiod ?>=? HDstart + HDwidth)  
Hperiod over 07 HPeriod in the horizontal timing data is outside the specified range. 
Hdisp over 08 Hdisp in the horizontal timing data is outside the specified range. 
Hsync over 09 Hsync in the horizontal timing data is outside the specified range. 
Hbp over 0A Hbackp in the horizontal timing data is outside the specified range. 
Hblank over 0B The blanking period in the horizontal timing data is outside the specified 

range. 
Hfreq over 0C The horizontal frequency in the horizontal timing data is outside the 

specified range. 
H-TIM data NG 0D Error other than those described above in the horizontal timing data. 
OUTPUT data error 10 Error in the output condition data. 
CHR data error 11 Error in the CHARA pattern data. 
CROSS data error 12 Error in the CROSS pattern data. 
DOTS data error 13 Error in the DOTS pattern data. 
CRCL data error 14 Error in the circle pattern data. 
BRST data error 15 Error in the burst pattern data. 
WIND data error 16 Error in the window pattern data. 
COLBAR data error 17 Error in the color bar pattern data. 
PARAMETER error 18 Error in a parameter in the terminal mode. 
DATA error 19 Error in the data in the terminal mode. 
SYNC data error 1A The sync signal has not been set. 
COMM. Timeout 1E Time-out has occurred during communication in the terminal mode. 
Undef Command 1F An undefined command was received in the terminal mode. 
V-Sync Timeout 20 Time-out has occurred during V sync interrupt wait. 
Prog-NO error 21 Error in the program number. 
Group-NO error 22 Error in the group number. 
User-CHR code error 23 Error in a user character code. 
EEPROM write error 24 An EEPROM write error has occurred. 
M-Card Type error 25 The memory card is not the correct type. 
M-Card Write error 26 A memory card write error has occurred. 
M-Card W-Protected 27 The memory card has been set to the write protect status. 
M-Card Not Set 28 The memory card has not been installed. 
M-Card UnFormated 29 The memory card has not been formatted. 
M-Card Full 2A There is no free space on the memory card. 
OPT PTN No error 2B Error in the optional pattern number. 
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OPT PTN FAT error 2C Error in user-generated optional pattern FAT. 
OPT PTN Not Registed 2D No user-generated optional patterns have been registered. 
BMP data No error 2E Error in the image data number. 
BMP data FAT error 2F Error in image data FAT. 
BMP data Not Registed 30 The image data has not been registered. 
Cur-DEV Incorrect 31 Illegal current data device (memory card or EEPROM). 
Key Not Available 32 The function cannot be used because the key lock function is activated.
CURSOR Not Selected 33 The cursor pattern has not been selected. 
OPT-0E(DDC) Disabled 34 The DDC optional pattern is invalid. 
Flash ROM write error 35 A flash ROM write error has occurred. 
GRAY data error 38 Error in the gray scale pattern data. 
OPT-PTN data error 39 Error in the optional pattern data. 
HALFTONE data error 3A Error in the half-tone pattern data. 
CURSOR data error 3B Error in cursor pattern data. 
PrgName data error 3C Error in the program name data. 
GCOLOR data error 3D Error in the graphic color data. 
ACTION data error 3E Error in the action data. 
Vtotal over 40 Vtotal in the vertical timing data is outside the specified range. 
Vdisp over 41 Vdisp in the vertical timing data is outside the specified range. 
Vsync over 42 Vsync in the vertical timing data is outside the specified range. 
Vbp over 43 Vbackp in the vertical timing data is outside the specified range. 
Vfp over 44 The front porch in the vertical timing data is outside the specified range. 

(Vtotal ≥ Vsync + Vbackp + Vdisp) 
Vblank over 45 The blanking period in the vertical timing data is outside the specified 

range. 
Vfreq over 46 The vertical frequency in the vertical timing data is outside the specified 

range. 
VD over 47 VDstart + VDline in the vertical timing data is outside the specified 

range. (Vtotal ≥ VDstart + VDline)  
EQPfp over 48 EQPfp in the vertical timing data is outside the specified range. 
EQPbp over 49 EQPbp in the vertical timing data is outside the specified range. 
V-TIM data NG 4A Error other than those described above in the vertical timing data. 
DDC1 Timeout 4B A timeout has occurred in DDC1. 
DDC1 ACK error 4C An ACK error has occurred in DDC1. 
DDC2 ACK error 4E An ACK error has occurred in DDC2. 

 
The following errors may occur when user-generated optional patterns are executed. 
Error message Code 

(HEX) 
Description of error 

OPT-Prog. not Exist 81 The user-generated optional pattern does not exist. 
Variables Stack Err 82 Variable stack error. 
Register Stack Err 83 Register stack error. 
Call Stack Error 84 Function stack error. 
Illegal Instruction 85 Illegal instruction code. 
Divide by Zero 86 An attempt was made to divide a number by zero. 
Math Error 87 An error has occurred in a floating decimal point calculation. 
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NOTICE 
● An incorrectly collated manual or a manual with missing pages will be 

replaced. 
● All copyrights pertaining to this product are the property of ASTRODESIGN. 
● This manual may not be copied in whole or in part without written 

permission. 
● The contents of this manual are subject to change without prior notice due 

to improvements. 
● The manufacturer will not be liable for any effects caused by incorrect 

operation. 
● All inquiries concerning this product should be addressed to your dealer or 

to the manufacturer at the contact numbers given below. 
● The products and product names mentioned in this manual are the 

trademarks and registered trademarks of the companies concerned. 
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